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INTRODUCTION: THE GRAIP METHOD 

 

 This introduction aims to describe, in a general sense, how this manual is 

organized and how to use it, what the steps to the data processing portion of a GRAIP 

study are, and how to keep the many files involved in this process organized. 

Specifically, this introduction will describe what software and ArcMap toolbars you will 

need to run the model, and what GIS skills are necessary to have before you begin the 

analysis. A section on ArcGIS 9 tips and tricks is also included. 

 

 

This Manual 

 

 This manual is part of a set of documents that describe all steps of a GRAIP 

study, from collecting data in the field, to this office analysis manual, to a tutorial that 

will give you a better idea of how the model works. 

The aim of this manual is to provide a set of fairly specific instructions for all 

parts of the office portion of a GRAIP analysis. It is organized in the order in which the 

steps are best completed and grouped in sections that contain steps towards a similar 

goal. There are three main sections in the manual, organized to reflect the three main 

steps of the office analysis, outlined below. Screen shots are included in order to reduce 

confusion. 

The best approach is to read though all of the section and sub-section 

introductions in order to get a complete picture of how the process will progress before 

beginning the analysis. Read the entire sub-section before you begin, so you have an idea 

of the results and goals of that sub-section. 

There are some conventions used in the manual that warrant explanation. Some 

terminology definitions are described in Appendix C. Italics indicate the title of an option 

in a menu or toolbar (e.g. File and Road Surface Erosion Analysis), a field in a window 

or column in an attribute table (e.g. Drain Points Shapefile and SedProd), or a button in a 

window inside ArcMap or an associated program (e.g. Add and Compute). An effort has 

been made to capitalize the same words that are capitalized in the various menus, titles, 

etc. involved in the process. The symbol -> is used to indicate a series of steps that do not 

need further explanation (e.g. click This-> click That-> navigate to file X-> click Add, 

etc.). Generally, a specific series of steps is only described in detail the first time because 

it is assumed that you will be following the steps consecutively. Figures are numbered 

and captioned only in the parts of the manual that are not step-by-step because the figures 

used to illustrate each step don’t need further clarification. Finally, “dem” is used to 

represent the name of a generic DEM so that it is easier to refer to grid files based on the 

DEM with new extensions. 

This update includes more details on running the model with certain calibrations 

(slope stability and gully risk), more details about how the model works (Appendix B), 

and some changes to the process to make certain steps easier, faster, or more accurate. 

Additionally, the function of the model has changed slightly to no longer include fish 

habitat patch information (this feature was time consuming, and its information could be 
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gleaned more easily from other sources). Fish passage barrier modeling is retained for 

optional use. 

 

 

Road Inventories and the General GRAIP Method 

 

An important first step in managing forest roads for improved water quality and 

aquatic habitat is the performance of an inventory (USDA Forest Service 1999). Methods 

for making a comprehensive inventory of forest roads and analysis of that inventory for 

watershed analysis are needed. The design of such methods must consider how roads 

affect the hydrology and water quality in forested watersheds (McCammon et al. 1998). 

The hydrologic and geomorphic effects of forest roads are closely linked to the 

linear nature of roads. Roads have a tendency to capture water and discharge it in one 

location. They may also route water across topographic gradients, redistributing and 

concentrating the flow and thereby increasing the probability of landslides, gully 

formation and sediment transport below the road drains (Megahan and Ketcheson 1996, 

Flanagan et al. 1998, Montgomery 1994, Wemple et al. 1996, Luce and Wemple 2001). 

Beyond the rerouting of water, roads also directly contribute sediments eroded from their 

surfaces to water bodies (Washington Forest Practices Board 1995, Cline et al. 1984, 

Megahan 1974, MacDonald 1997, Luce and Black 1999). The fundamental 

considerations in the design of a road inventory and analysis procedure for assessing 

watershed related effects of roads should focus on the questions; 1) Where are runoff and 

sediment generated or intercepted by roads, and 2) Where do the water and sediment go? 

The inventory and analysis methods detailed in this document were designed with 

these principles in mind. It is expected that the GPS and GIS will be the primary tools in 

the implementation of the inventory and analysis. Because there are errors in location 

information from GPS and in digital elevation models, some redundancies are built into 

the procedure to ensure that water movement is specified in the field.  

 There are two general scales at which to apply the GRAIP method. The preferred 

appraoch is to inventory an entire watershed at once, with the goals of determining where 

road problems are located, so that they can be fixed, and of determining how much extra 

sediment and mass wasting risk is associated with the road network in that watershed 

(e.g. Fly et al. 2010, Nelson et al. 2010B). The secondary way is to apply GRAIP on a 

small scale as a project monitoring tool. A road or set of roads is inventoried before and 

after a road treatment (such as decommissioning or water-bar installation) in order to 

determine the effectiveness of that treatment (e.g. Black et al. 2009, Nelson et al. 2010A). 

In this second method, untreated control roads that have similar properties to the 

treatment roads are also inventoried so that the effectiveness of the treatments can be 

gauged by re-inventorying all of the roads after a large storm event. Updated reports and 

more information can be found on the GRAIP website 

(http://www.fs.fed.us/GRAIP/index.shtml). 

The primary goal of a road sediment inventory is to document the sources of 

sediment and how they interact with the road and are ultimately routed to the hillslope 

and stream network. It is useful to break the road drainage system up into three 

components. We examine the road prism and ditches as one component of the system, 
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where much of the water and sediment are generated. Points where the flow is diverted 

off of the road are examined as the second component to determine where they occur and 

how they function. The third component examines the type of surface and flow path 

where the water is discharged below the road drain point. Basic information about the 

hillslope flow path below the discharge point will allow us to make inferences about the 

sediment delivery to nearby streams.  

This method is designed to quantify the rate of surface erosion related to overland 

flow of water. It can also be used to assess the risk of mass movement and gullying. The 

GRAIP inventory also provides an updated map of the extent of the road network and an 

inventory and condition map of road assets such as culvert pipes, water bars, gates, and 

road closures. It is possible to use this inventory opportunity to provide a first order 

assessment of fish passage potential at stream crossing culverts (Washington State 

Department of Fish and Wildlife 2000). Significant improvement in fish passage 

assessments may be achieved by application of a more thorough inventory and analysis 

procedure such as Fish Xing (Six Rivers Watershed Interactions Team 1999). 

When a road inventory is conducted for watershed analysis, the road network will 

likely include multiple ownerships. The quality and extent of available data on roads may 

vary dramatically by ownership and region. Due to these limitations of data availability 

on forest roads and their hydrologic properties, we have chosen to utilize a GPS device to 

collect the location information on point and line features associated with the road 

network. Predictions of road sediment production are made for each road segment 

utilizing the information on road attributes, condition, length and slope. These predictions 

are made based on either locally collected sediment plot data for typical road segments 

(Luce and Black 1999, Luce and Black 2001) or values from comparable regions 

available in the literature (Megahan and Kidd 1972, Megahan 1974, Reid and Dunne 

1984, Swift 1984, Bilby et al. 1989, Ziegler et al. 2001). An outline of a simple method 

for setting up local road erosion plots is available (Luce and Black 1999). 

The road network is divided into road line segments, where the entirety of that 

road segment shares the same condition attributes. The data dictionary used in field data 

collection allows for a thorough documentation of the parameters of the road (Black et al. 

2010). The attributes of the road line, such as the surface type and surface vegetation 

percent, are divided into classes in the appropriate menu. The road line is ended and a 

new segment begins when a new drain point is encountered, a grade reversal occurs, or 

one of the attributes changes from one class to the next. The road line describes three 

types of information; 1) on which part of the road is concentrated flow traveling (flow 

path, e.g. ditch location), 2) the drainage feature receiving discharge from that road 

segment, and 3) the physical condition of the road prism. At each road drainage feature, 

evidence is collected documenting the ultimate destination of the water as it encounters 

the hillslope. Each drain point is associated with the contributing road segments using the 

time stamp given when the drainage feature is opened. 

Road inventories completed in this manner are a valuable tool for prioritization of 

road maintenance and watershed restoration efforts. They are probably one of the least 

expensive tools applied to the problem of road maintenance and restoration. Engineers 

from federal agencies and private forestland companies have eagerly used data collected 

with these methods for many projects. 
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The Steps 

 

 There are three main groups of steps in the data processing portion of a GRAIP 

study. Each group is organized in the three Sections, and can generally be completed on 

its own. First, the field data must be made into GIS shapefiles. The field data is imported 

into Pathfinder Office (discussed below), where it is differentially corrected to remove 

atmosphere-related GPS error, and then exported as GIS-ready shapefiles.  

 Next, the shapefiles and the DEM must be preprocessed for GRAIP. The DEM 

must be clipped to watershed boundaries, the DrainPoints and RoadLines shapefiles used 

by GRAIP for analysis must be created, and their errors corrected and road lines 

straightened. 

 Finally, the actual GRAIP analysis can begin. TauDEM and SINMAP are used to 

create a series of grids and shapefiles that are used by GRAIP. SINMAP is used to create 

a series of grids used both for the mass wasting analysis step and for comparison, so that 

the affect of the roads on slope stability can be assessed. There are three main groups of 

GRAIP functions in the analysis, found in the GRAIP toolbar. The first group calculates 

the sediment production, and its accumulation at drain points, as well as its delivery and 

accumulation in the streams. The second set of GRAIP functions analyzes the impact of 

the road drainage on terrain stability. A grid similar to that produced by SINMAP, but 

which takes the water from the roads into account and illustrates slope stability, is 

produced for comparison, as well an index number at each drain point that indicates the 

likelihood of gullying at that drain point. The last function analyzes the potential 

blockage of fish passage at stream crossings. There is more information about what 

exactly each step and series of steps does available in Appendix B. 

 Generally, a GRAIP analysis must be completed in the order presented in the 

GRIAP toolbar. However, certain steps of this process can be completed out of order. 

Also, there is an additional complication involving the Combined Stability Index step, 

which is presented and explained on the text. You may want to check the quality of the 

incoming field data daily or weekly, so that a field crew can return to fix any errors that 

cannot be resolved in the office. You may also want to get as much data ready for GRAIP 

analysis as possible, but not run the analysis because more data is being collected that 

will be added to the already collected data. The first thing you must do before anything 

else is turn the field data into shapefiles. From there, you can straighten the road lines 

directly or you can run the GRAIP Preprocessor and correct the errors you find, first. If 

you are conducting a watershed-wide study, it is recommended that the data be checked 

for errors and corrected frequently, so that any errors that are irreconcilable in the office 

can be re-visited by a field crew. You can also run TauDEM and SINMAP separately, 

after clipping and preparing the DEM. If you do this, make sure your file system doesn’t 

change before the rest of the analysis is begun. It is a good idea to complete all of the 

GRAIP toolbar analysis steps at once. 
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Necessary Software and ArcMap Toolbars 

 

 A GRAIP analysis requires a number of software packages that are not included 

with the GRAIP download. You must be running Windows 2000 or newer to install a 

number of these packages. All pieces of software should be installed before GRAIP is 

installed. You will need ArcGIS 9.2 or 9.3 with the ArcInfo and Spatial Analysis 

licenses, Trimble GPS Pathfinder Office 4.0, TauDEM, SINMAP 2.0, Hawth’s Tools, 

and finally the GRAIP Toolbar and GRAIP Preprocessor. The GRAIP set should be 

installed after everything else. Additionally, an internet connection is required for the first 

steps (Section I).  

For more information about obtaining and installing ArcGIS, see the ESRI 

website (www.esri.com). For more information on obtaining and installing Pathfinder 

Office, see the Trimble website (www.trimble.com/pathfinderoffice.shtml). ArcGIS must 

be installed prior to installing the rest of the toolbars. 

 There are five toolbars and a window that are standard to ArcMap (Figure 1). It is 

good to be familiar with them. The Main Menu toolbar contains general ArcMap 

controls, like Save and open ArcCatalog. The Standard toolbar contains buttons that 

generally do the same things as some of the options in the Main Menu, but are more 

conveniently located. The Tools toolbar contains buttons that control the map’s extent, 

feature selection, and some other similar controls, many of which are also under the Main 

Menu, too. The Editor toolbar contains tools used to create and edit points, lines, and 

polygons in shapefiles. The Spatial Analyst toolbar contains the Spatial Analysis tools, 

such as the Surface Analysis tools and Raster Calculator…. The Table of Contents 

window shows which layers are present in ArcMap, their symbology, their stacking 

order, and if they are visible or not, and allows you to change those aspects. You can see 

Figure 1. The six standard toolbars and window. Each of 

these can be dragged into the main ArcMap window. 

Click the toolbar header, and drag the window or toolbar 

to any edge of the screen until the window or toolbar 

outline changes from thick gray to thin black. 
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what a tool is called by hovering the mouse pointer over the tool until the label shows up. 

The area of the ArcMap screen that displays the map data is referred to as the map 

viewer. 

We recommend TauDEM 3.1, as newer versions may not be compatible with the 

other aspects of GRAIP. TauDEM 3.1 can be obtained from its website 

(http://hydrology.usu.edu/taudem/taudem3.1/index.html). Additional information and 

installation instructions are available there. Download the appropriate files and open the 

installation executable (extension .exe). Follow the on-screen instructions. Then, in the 

ArcMap Main Menu-> Tools-> Customize…-> click on Add from file…-> navigate to the 

location of the installation and click on agtaudem.dll-> click Open-> click OK to added 

objects-> scroll to 

Terrain Analysis using 

digital elevation 

models (TauDEM) 

under the Toolbars tab 

and check its box if it 

isn’t already checked-> click Close in the Customize window (Figure 3). The TauDEM 

toolbar should now be present in ArcMap (Figure 2). You should only have to do this 

once (i.e. when you open ArcMap again, the TauDEM toolbar should still be in the 

window. Other versions can be found at http://hydrology.usu.edu/taudem/versions.html. 

 Installing the remaining toolbars is similar. For SINMAP 2.0 (Figure 4), go to its 

website (hydrology.neng.usu.edu/sinmap2). There is substantial documentation on the 

website, if you desire to learn more. Download the appropriate file (SINMAP 2.0 

setup.exe) and open the file. Follow the 

installation instructions. In the ArcMap 

Main Menu, do as before. From the 

Customize window, add the file Figure 4. The SINMAP toolbar. 

Figure 3. The Customize... window, used for changing which toolbars are displayed and which tools 

are present in each toolbar. 

Figure 2. The TauDEM toolbar. 
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agSINMAP.dll, and check the box next to Stability Index MAPing(SINMAP). 

 For Hawth’s Tools (Figure 5), go to its website 

(www.spatialecology.com/htools/download.php). Hawth’s Tools are now out of date and 

replaced with Geospatial Modeling Environment, however Hawth’s is still available. The 

Tools work best with ArcGIS 9.3. There is additional 

information about the Tools on the website. Download 

and unzip the appropriate file. Open htools_setup.exe and 

follow the instructions. From the Customize window, add 

the file HawthsTools3.dll and check the box next to 

Hawth’s Tools. 

 For the GRAIP Toolbar and Preprocessor (Figure 6), go to the program website 

(www.neng.usu.edu/cee/faculty/dtarb/graip/) and download the appropriate files for the 

current version. Open GRAIPSetup.exe and follow the on-screen instructions. From the 

Customize menu, add the file agGRAIP.dll, and check to box next to Geomorphic Road 

Analysis and Inventory Package(GRAIP). Additional information and updates can also be 

found at the main GRAIP website (http://www.fs.fed.us/GRAIP/index.shtml). 

The GRAIP Preprocessor and the tutorial package are also installed in the same 

directory as the rest of the GRAIP package. Additionally, the binary libraries 

consolidateShp.dll and graipCOMDLL.dll are installed. These files and agGRAIP.dll 

make up the Preprocessor and Toolbar. The GRAIP database template, GRAIP.mdb, is 

also installed for use by the Preprocessor. 

The version of GRAIP.mdb that is included 

with the GRAIP download above is 

compatible with the data dictionary (which 

is what is used for field data collection) 

INVENT 4.2. The latest (at time of writing) 

data dictionary is INVENT 5.0, which is 

available at the Forest Service GRAIP 

website 

(http://www.fs.fed.us/GRAIP/downloads.sht

ml), along with updated versions of 

GRAIP.mdb. The tutorial folder contains 

the tutorial manual and a zipped data file 

that contains the “demo” folder which 

contains all of the tutorial data (the DEM 

called dem, and a shapefiles folder that 

contains BBdip.shp, Diffuse.shp, 

Ditchrel.shp, Lead_off.shp, ned.shp, 

Str_Xing.shp, sump.shp, waterbar.shp, and 

road.shp). In order to follow the tutorial, 

you need the tutorial files. Unzip them to a 

good working directory. A shortcut to the 

Figure 5. The Hawth's 

Tools toolbar. 

Figure 6. The Extensions window. The Spatial Analyst 

extension is highlighted. 

Figure 7. The GRAIP toolbar. 
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GRAIP Preprocessor is installed in the Windows Start menu. 

The ArcGIS Spatial Analyst extension must be unlocked so that GRAIP can use 

certain features (Figure 7). From the ArcMap Main Menu, Tools-> Extensions-> check 

the box next to Spatial Analyst-> click Close. If the Editor and Spatial Analyst toolbars 

are not present in the ArcMap window, check the boxes next to them in the Toolbars tab 

of the Customize window from above. 

 

 

Necessary GIS Skills 

 

 It is helpful to have basic GIS skills before you use the GRAIP tools, but not 

necessary. This manual assumes a novice GIS skill level so that more people will be able 

to use it. Most basic processes are explained in enough detail so that someone who has 

never done that process before will be able to without trouble. It is best to at least know 

the general layout of ArcMap and ArcCatalog, and have a reasonably high level of 

computer literacy. It is helpful to be comfortable with defining and changing projections, 

using the Editor toolbar to edit shapefiles and their tables, and changing the symbology of 

layers in ArcMap. Also, it is good to be comfortable with using the tools in ArcToolbox, 

and moving and making copies of layers, and creating new workspaces in ArcCatalog. 

 

 

Organizing Your Files 

 

 File organization is an important component of any GIS task, and a GRAIP 

analysis is no exception. There are multiple stages of the same basic data, and many files 

are created and modified during the process. Many of the files are very large, often 

resulting in very large workspaces. Even if you have multiple sets of roads in the same 

watershed (as you might if you are comparing a set of roads before and after they are 

worked on), you will want each set of data to have its own unique set of DEMs and other 

rasters (such as the TauDEM- and SINMAP-created files). It is recommended that you 

have a file system established before you begin analysis. 

Some guidelines are useful when creating your file system. First, whenever you 

want to create a new workspace, or move or copy a GIS file (shapefiles, grids), use 

ArcCatalog. This is much simpler and more reliable than the same tasks in Windows. 

You won’t have to find all of the separate files that go into making one shapefile or grid. 

Second, do all of your work in ArcInfo Workspaces instead of regular folders. These can 

be created in ArcCatalog by right-clicking in the directory in which you want to create 

the workspace and choosing New-> ArcInfo Workspace (Figure 8). Keep in mind that you 

will have a hard time finding old data if you do not name everything clearly and 

consistently. Include a text file with your naming scheme and file system in the main 

workspace if you intend to store the data for long periods. Thirdly, as suggested above, 

create all of the necessary workspaces and structure before you begin analysis. This can 

reduce confusion later. It helps to write down all of the file paths in the file system for 

reference so you don’t have questions about what should have gone where. Fourthly, do 
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not put your files and workspaces 

directly on the C drive. Finally, 

TauDEM, SINMAP, and GRAIP 

all require that there are no spaces 

in any file paths that they need to 

use, and that all files that they use 

directly (shapefiles, grids) have no 

more than eight characters (your 

workspaces can have long names, 

but no spaces). The DrainPoints 

and RoadLines shapefiles are 

exceptions to this rule. Generally, 

if you are renaming a shapefile or 

grid, do not allow the name to have 

more than eight characters. It is 

recommended that you complete 

the metadata for your final grids 

and shapefiles for documentation 

purposes. 

 Each basic file system 

should have a working workspace 

that contains only and all of the 

files that apply to that particular 

site or area. In this workspace, you 

should have a copy of the DEM 

you are using, as you plan on using 

it (clipped, with the correct 

projection; see Section II) in its 

own workspace. Also under the 

working workspace, there should 

be a workspace for the shapefiles, 

as well as the files created by the 

GRAIP Preprocessor. TauDEM will save its files to the DEM’s workspace, and SINMAP 

will create its SINMAPData folder there. During the GRAIP process, there are some grid 

files that are created. Their default saving locations (to the DEM’s workspace) should be 

okay. An example file system can be found in Appendix A. 

 There are other systems possible, some of them probably simpler. The important 

part is that you understand your system. It is worth noting that, often in the GRAIP 

process, a file will be created that is used later in the process. If you move the location 

that the file is saved to, GRAIP will remember that as the default location for that file as 

long as that GRAIP file remains open. If you close and re-open ArcMap or otherwise 

have to re-open the GRAIP file, you will have to manually locate those files which were 

saved elsewhere than default. This applies to renamed files, too. Finally, if you are 

sharing this data with other people, it is easiest to export the GRAIP files (DrainPoints, 

RoadLines, demnet) as layer files so that the person on the receiving end does not need to 

use your file system or even have GRAIP installed. 

Figure 8. A completed GRAIP project and its file system. The 

DEM is called uma_w, and the other grids were created by 

TauDEM, SINMAP, or GRAIP. Also shown is the path to create a 

new ArcInfo Workspace. 
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Tips and Tricks for ArcGIS 9 

 

ArcGIS is a large and complicated set of programs. Tools don’t always work the 

way they should, or they may not work with your specific dataset for some reason. 

ArcMap and its toolbars can crash. Some small detail within the data can be wrong or 

corrupted, and the data won’t 

work with the tools you need.  

GIS help and training is 

abundant, and usually very useful. 

There is a desktop help that comes 

with ArcGIS. Go to the ArcMap 

Main Menu-> Help-> ArcGIS 

Desktop Help. ESRI has an 

extensive online help section, 

accessible from the Help menu or 

via the ESRI website 

(www.esri.com). The ESRI 

website also has some training 

options. Here are some tips and 

tricks for using GIS in general, as 

well as a couple of specific 

examples that apply to a GRAIP 

study. Remember, patience is a 

virtue!  

 First, there are some usability tricks. The GRAIP process uses a lot of toolbars 

that you will probably want to display all at once. If your screen resolution is too low, 

you might have to move toolbars around to make the most efficient use of your screen 

space at any one time. To increase the screen resolution, go to the computer desktop-> 

right-click-> Properties-> Settings tab-> Screen area field-> slide the bar over towards 

More-> click Apply-> click OK-> click OK 

(Figure 9). This process is slightly different 

from computer to computer, depending on the 

operating system, etc. 

The individual tools that are available 

in the Standard toolbar and Tools toolbar are 

customizable (Figure 10). In order to 

customize which tools are displayed, go to 

the ArcMap Main Menu-> Tools-> 

Customize…-> Commands tab. From here, 

you can navigate through the Categories and 

drag the Commands you want to the 

appropriate toolbar. Some useful commands, 

where the underlined commands are not in 

Figure 9.  The Display Properties window on a Windows XP machine. 

Figure 10. The Commands tab of the Customize... 

window. Some useful tools are displayed under the 

Selection category. 
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the toolbars by default, are, Zoom In/Out, Fixed Zoom In/Out, Pan, Zoom Full Extent, 

Go To Previous/Next Extent, Clear Selected Features, Pan To Selected Features, Zoom 

To Selected Features, Identify, and Measure in the Tools toolbar, and New Map File, 

Open, Save, Delete, Add Data, ArcCatalog, ArcToolbox, and Add Image Service (for 

Forest Service users; available online at 

http://fsweb.rsac.fs.fed.us/imageserver/imageserver.html) in the Standard toolbar.  

There are times when there is a certain sub-full extent is useful to be able to return 

to, such as if you have a regional background image displayed, and you want to zoom to 

the relatively small watershed you are working in. You can create an extent bookmark. 

Go to the ArcMap Main Menu-> View-> Bookmarks-> Create…-> type a name-> click 

OK. To use the bookmark, go to View-> Bookmarks-> click on the bookmark name. In 

ArcCatalog, you may need to refresh a window before the modifications you have made 

in ArcMap (such as the creation of new shapefiles) show up. Right-click in the directory-

> Refresh. 

 One of the most important things you can do is save your work often. However, 

you do not usually need to save the map file, because changes made to individual 

shapefiles and their tables are made directly to those. If you are editing a shapefile, save 

the edits in the Editor toolbar frequently (Editor-> Editor drop-down-> Save Edits). 

When you create a new shapefile or grid, it is saved on the hard drive. On a related and 

more important note, back up your data at least once daily. The back-up file system 

should be the same as the working file system. 

 Data projections are sometimes tricky. It is important to have all of the data in the 

same projection, whether or not that projection is defined. If the data was exported to 

shapefiles in the wrong projection, it will likely not be registered correctly with the DEM 

or background image, and you will have to re-project it into the correct projection (see 

Section II). If the DEM is in the wrong projection, you may re-project it, but make sure to 

use the correct technique (see Section II). ArcMap attempts to “project on the fly,” where 

the first layer added to the map file defines the projection for everything else that is 

added, but only if what is added does not have a defined projection. When you open a 

new map file, the projection of the viewer is reset. Whenever you change or define the 

projection of a shapefile or grid, open a new map file and re-add those layers. Open a 

new map file whenever you change the dataset you are working with (as opposed to 

removing the layers in the map and adding new layers). You will probably encounter 

messages about data you are adding or editing being in the wrong projection, or not 

having a defined projection. Usually, you can ignore those. If you encounter another 

problem and you have encountered one of those messages in regards to a layer you are 

working with, the projection/ projection definition is the first thing you should check and 

fix. To check this, right-click in the layer name in the Table of Contents in ArcMap-> 

click Layer Properties to open the Layer Properties window for the layer-> Source tab-> 

scroll down to Spatial Reference, expanding the line if necessary. 

 If you encounter a problem with a tool in ArcMap or a toolbar, try it again. If it 

still does not work, close ArcMap, delete any file it might have started to create in 

ArcCatalog (this will look like whatever file the tool was supposed to create), and re-

open ArcMap. Try it again. If the same problem occurs, delete any file the tool may have 

started to create, close all programs, restart the computer, and try it without ArcCatalog 

open. If the problem persists, there is some conflict with the tool and your data, with the 
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tool and ArcGIS, etc. Seek additional help. If you look in the desktop help or online, look 

up the tool to see if it has any special requirements that are not met by the input data (e.g. 

the tool might require all projections to be defined). If ArcCatalog is open, make sure that 

the directory that is displayed is not the same directory you are working under in 

ArcMap, or things will get confused. Often, it is best to not have ArcCatalog open at all 

when working in ArcMap. 

 Restarting ArcMap works at least half the time. In fact, it is a good idea to restart 

the ArcGIS components on a regular basis as a preventative measure. Keep in mind that, 

if you restart in the middle of the GRAIP process, and the grids are being saved to a non-

default location or have non-default names, GRAIP won’t remember, and you will have 

to specify the name/location of a particular file yourself. As you go along with multiple 

data sets, you might find that there are certain errors that repeat themselves, either 

because there is a common problem with the data, or a problem with the tool (or how the 

tool relates to the your data type, etc.). Note what the solution to these problems are, and 

repeat that each time. If you locate a problem with GRAIP, please email Tom Black at 

tblack@fs.fed.us. We will attempt to aid in finding a solution and will add it to our FAQ. 

 The first example of an error occurred with the Combined Stability Index function 

in the GRAIP toolbar (see Section III). This function uses some inputs that were created 

with SINMAP, and outputs a grid file. All inputs would be correctly specified and 

located, but when the function was executed, it would come back with an error. Re-

opening ArcMap and restarting the computer did not help. There was no partial file 

created. However, the DEM that was used had been re-projected incorrectly, and so an 

error was generated before the output grid file was even created. The solution was to go 

back to the original DEM (before the re-projection), which had been saved, and re-project 

it using the correct method, and then re-run the GRAIP Preprocessor and all of the 

GRAIP toolbar functions to that point (see Sections II and III). This is a good example of 

a user-caused error, and one that is all too easy to do. 

 The second example of an error occurred in SINMAP, during the final step. This 

happened with the same incorrectly re-projected DEM as above. SINMAP needs to be 

run all in the same session. The error occurred when Compute All Steps under the 

Stability Analysis menu in the SINMAP toolbar was initiated. ArcMap would freeze, and 

a Windows End Task dialog would appear. The initial solution was to click End Task, go 

into ArcCatalog and delete all of the already-created grids (in previous SINMAP steps), 

and then re-run all of the SINMAP functions. This happened twice before SINMAP fully 

worked. However, this was not a very good solution. The errors in the DEM that were 

generated by the incorrect re-projection were the cause of this error, and the series of 

restarts and deletes were only good luck. A better solution was to do the same as above—

correctly re-project the original DEM. This better solution was not discovered until the 

first error example had happened, and the correctly projected DEM got through SINMAP 

without any errors. 

That last example illustrates that a solution such as closing and re-opening 

ArcMap is often just a Band-Aid for some other problem that has a better solution. 

However, it is often difficult to pin-point that other problem, so finding the better solution 

is impractical. The Band-Aid restart is usually good enough. If that is the solution you 

pursue, you should pay extra careful attention to the output data from that point forward 
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to ensure that all of the data makes sense and no unforeseen errors or inaccuracies have 

occurred. 
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SECTION I: FROM FIELD DATA TO GIS SHAPEFILES 

 

 This section describes the first step in a GRAIP study; changing the data from the 

format used by the GPS systems in the field to the format used by ArcGIS. The data must 

first be brought into Pathfinder Office with the correct format. Next, a differential 

correction is performed using downloaded base station data in order to remove data 

points that have very low precision (an internet connection is required for this step). 

Finally, the differentially corrected files must be exported into their final format, which is 

the GIS shapefile. These instructions are for Pathfinder Office 4.0. Other versions may be 

different in some respects. 

 

 

Transferring Field Data into Pathfinder Office 

 

 Data is collected in the field with the Trimble TerraSync software. Data is saved 

as a set of eight or nine files with the extensions .car, .dd, .gic, .gip, .gis, .giw, .gix, .obs, 

and .obx (the file with extension .car does not exist if there are eight files; Figure 11). The 

default naming theme that TerraSync uses includes the date and 

time that the file was created (for example, R071215A was 

created on 7/12 at 3 pm). An example of a TerraSync file might 

be R071215A.gic. In order for these files to be usable in 

Pathfinder Office, their format must be changed to the SSF (file 

extension .ssf) from that set of files. This is accomplished by 

transferring the data into Pathfinder Office. 

 There are a number of devices that can be used for field 

data collection, from laptops to small handheld field PCs. The 

methods for retrieving data from each of these devices are 

different, and so are not explained here. It is assumed that all of 

the data is accessible from the computer you are using. You 

will need all eight or nine TerraSync files, depending on how 

many are created by default with your particular field data 

collection device. 

 It is important to keep the raw data and Pathfinder Office files organized so you 

know where to look in the future. You should keep these data in a folder separate from 

the ArcGIS workspace, and, if you have multiple sites, or will have multiple sites 

sometime in the future, each site should get its own sub-folder (a site might be all roads 

in a watershed, or the roads in a road decommissioning study before they have been 

worked on, with a second site for after they have been worked on). You should keep a log 

of every TerraSync file and what part of which road each file contains. 

 

1. Move or copy all of the relevant raw data into whichever folder your want to use. 

Figure 11. All 

nine possible 

TerraSync files. 
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a. Relevant data are all eight or nine TerraSync files for each file name 

(R071215A.gic, R071215A.dd, etc.). 

b. Keep the raw data separate from the GIS workspace. 

2. Open Pathfinder Office. 

a. Go to the Windows Start menu-> Programs-> GPS Pathfinder Office (version 

number)-> click on GPS Pathfinder Office to open. 

3. Select the project folder. This is the place where all of the files that Pathfinder Office 

creates will be saved. 

a. If the Select Project window does not automatically open, go to File-> Projects…. 

b. If you are working with an already created project, use the Project Name drop-

down menu to select it and click OK. Skip ahead to step 4. 

c. If you do not have a folder set up for the current project, you must set one up now. 

Go to New…. 
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i. Next to the Project Folder field click Browse…-> navigate to the location of 

the raw data files-> click on the folder that contains those files-> click OK. 

ii. The Backup Folder, Export Folder, and Base File Folder are subfolders 

automatically created in the project folder. Check to make sure they will be 

created in the same place by clicking Browse… next to one of those fields. 

iii. In the Project Name field, enter a name that makes it clear which folder is 

referenced. 

iv. Click OK to create the project folder. 

 Click Yes if the error message that says, “Folder already exists; Do you 

want to continue?” pops up. 

d. Click OK to select the new project. 

4. Go to the main menu-> Utilities-> Data Transfer… 

a. Pathfinder Office is set up to talk directly to whatever device you use to collect 

field data, but we do not want to do this. Instead, we want to use data already on 

the hard drive of the computer. These methods are un-intuitive because of this. 

b. Ensure that the Receive tab is selected. 
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c. If you already have the relevant folder connected, click on the Device drop-down 

to select it and skip to step d. If you do not already have the relevant folder 

connected, you will need to connect it. Click Devices… 

i. Click New…. 

ii. Select GIS Folder as the type of device you wish to create-> click OK. 
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iii. Click Browse… to navigate to and select the Project Folder (created above)-> 

click Next. 

iv. Use the drop-down menu next to Type to select TerraSync, and then select the 

Version closest to that used in the field-> click Next. 
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v. Give the device a short name (under nine characters) in the Name field-> click 

Finish. Click Close to close the Devices window. 

d. Click the Add drop-down in the Data Transfer window-> wait for Pathfinder to 

connect to the device folder if necessary-> click Data File. Select the relevant 

data files (only those with a .gis extension show up)-> click Open. Those files are 

added to the Files to Receive field. 

e. Click Transfer All. 
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f. The Transfer Completed dialog appears. This dialog will tell you if the transfer(s) 

was/were successful. You should check on the location of the transferred files by 

clicking More Details…to access the log file and looking at each file path. The 

files should be transferred to the same directory as the raw data files. The format 

is converted to SSF (extension .ssf). There is a backup of the SSF file saved to the 

Backup folder in the project folder by default. Click Close when satisfied. Click 

Close to close the Data Transfer window. 

5. View the data to ensure that it is what you want. 

a. From the main menu, go to View-> Map. If necessary, select the SSF file(s) that 

you just created-> click OK. 
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Differential Correction 

 

 GPS data contains many small errors due to factors associated with the satellite, 

such as its orbit being slightly off or interference from the atmosphere. Most errors of this 

type can be eliminated by performing a differential correction after the data has been 

collected (Figure 12). Differential correction uses data downloaded from a nearby base 

station to move and delete GPS points in error by comparing points from your data to the 

base station data. In this way, accuracy is improved. 

Not every error can be removed by differential correction (Figure 12). Many, if 

not most, errors that show up as zigzags in the road line will remain, and must be 

corrected by hand, 

as discussed later. If 

all of the positions 

that make up a 

feature (e.g. a road 

line) are 

uncorrectable, then 

the differential 

correction will 

remove the feature. 

There are some 

steps to take that 

ensure that this will 

not occur, and these 

are discussed below. 

An internet 

connection is 

required for this step in order to use the most up-to-date base station data. 

 

1. With the same project folder open as above, got to Utilities-> Differential 

Correction…. 

Figure 12.  A section of road before (right) and after (left) differential correction.  

Areas where the differential correction changed the road line are noted. 
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2. The Differential Correction wizard appears. 

a. If the correct files do not appear in the Select SSF files to correct field, click the 

plus sign-> navigate to and select the relevant files-> click Open. If the incorrect 

files appear, in the Select SSF files to correct field, select them and click the X 

below the plus to remove them. Click Next when finished. 

i. Below the Select SSF files for correction window, there is some information 

about the file. 

 Date and time range of collection, location on the hard drive, number of 

GPS positions in the file, and whether or not the file was collected using 

an H-Star GPS receiver (H-Star allows for greater accuracy). 

ii. You should only correct multiple files if they are geographically near (within 

about 50 miles), because it is necessary to use a nearby base station. 

b. If the data was collected with an H-Star receiver, select Automatic H-Star Carrier 

and Code Processing. If the data was not collected with an H-Star receiver, the 

options under H-Star will be grayed-out. If that is the case, select Automatic 

Standard Carrier and Code Processing. Click Next. 
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c. The settings on the next screen can be adjusted by clicking the Change button. 

We want to ensure that differential correction does not remove any feature 

because that feature’s positions cannot be corrected. 
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i. Click Change-> click the Output tab-> under Output Positions, ensure that the 

radio button next to Corrected and Uncorrected is selected-> click OK-> click 

Next. 

ii. You should only have to do this one time, as these settings are saved. 

However, since missing this step could result in the loss of data, it is a good 

idea to check this setting about once per day that you use the differential 

correction. 

d. Click Select next to the Base Provider Group field. 
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i. This window looks different if your data was collected with a receiver that is 

not H-Star enabled, but the process is similar. If this is the case, you will click 

Select next to the Base Provider Search field, and skip ahead to step iii, 

below. 

ii. If you have an appropriate group already, select it from the Base Provider 

Group drop-down menu, check to make sure the selected base station is still 

the best option (plus sign-> Update List), and skip ahead to step iii. If you do 

not already have an appropriate group, click New… next to the Base Provider 

Group drop-down menu. Name it something obvious-> click OK. 

iii. Click the plus sign. A list of base stations appears, with their distance from the 

data and an integrity index (higher is better).  
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 Click the Update List button to acquire the latest list. The Downloading 

base providers… window appears while the download is taking place.  

 Generally, the CORS base stations are the best choice. Select a nearby 

base station, with a relatively high integrity index and a bias towards 

CORS stations. If you have H-Star data, you can select multiple base 

stations. The more base stations you select, the longer it takes to complete 

the differential correction, but the greater are the chances of correcting all 

data. 

 Click the Properties… button to show some more information about the 

selected base station, such as the organization responsible for running the 

base station, and its precise location, in latitude-longitude and altitude. 

 Click OK to exit the Select Base Provider window. 

iv. Click OK to exit the Base Provider Group window.  

e. Select Use reference position from base providers in the Reference Position 

section of the window. Check the box next to Confirm base data and position 

before processing. Click Next. 

f. Select where you want the new corrected data file (extension .cor) to be saved and 

how you want it to be named. Click Start. 
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i. If base data cannot be downloaded for some reason, click Back twice, select a 

different base station, and try again. 

ii. Click Confirm when required. 

g. When the process is complete, the window will say “Differential correction 

complete.” You should look at the data in the window to confirm that the 

correction was successful. 

i. Useful data includes the number of positions corrected, the number 

uncorrected, which method (carrier or code) was used for how many 

positions, how many positions were thrown out, and estimated accuracies for 

the data. 

ii. When finished, click Close. 
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Exporting Data as Shapefiles 

 

 The final data must be in the GIS shapefile format so that ArcMap and GRAIP 

can analyze it. The differentially corrected data files (extension .cor) are exported as 

shapefiles. The new shapefiles are saved by default to the Export folder in the project 

folder. You will want to either move, copy, or save them initially to a workspace for GIS, 

as discussed in the Introduction. Each single differentially corrected COR file turns into a 

set of shapefiles, one for each feature. Additionally, you can export multiple COR files at 

once, and they will all contribute their data to a single set of shapefiles. The number of 

shapefiles created depends on the data collected. For example, if the crew did not collect 

any ditch relief points, then there will not be any shapefile exported called DTCH_REL, 

which would contain the data for the observed ditch relief culverts. All of the possible 

shapefiles are BBASE_DI, DIFF_DRA, DTCH_REL, END_RD, EXCAV_ST, GATE, 

GULLY, LANDSLID, LEAD_OFF, NON_ENGI, PHOTO, Point_ge, REVISIT, ROAD, 

ROAD_CLS, ROAD_HZR, STRM_CRO, SUMP, and WATER_BA. Sometimes, data 

will be exported so that there are more than one of certain shapefiles (e.g. ROAD and 

ROAD2). This seems to be due to significant differences in collection dates or in the data 

dictionaries used for data collection. This does not have any effect on the processing of 

the data or its results. 

 

1. With the same project folder open as before, go to the main menu-> Utilities-> 

Export…. 

2. The Export window appears. 

a. In the Input Files section, click Browse...-> navigate to the location of the 

differentially corrected file or files that you wish to export to shapefiles-> select 

the necessary COR files-> click Open. 
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b. You can change the location of the output folder by clicking Browse… next to the 

Output Folder field. You may find it easier to use the final destination of the 

shapefiles (GIS workspace) for simplicity. Note that if you export to a location 

that already has GRAIP shapefiles in it, you will overwrite those shapefiles. 

c. In the Choose an Export Setup section of the window, choose Sample ESRI 

Shapefile Setup from the drop-down menu. 

d. Check the coordinate system in the area under GIS Coordinate System to make 

sure it is correct. If using UTM, make sure the zone is set correctly. Rectangular 

systems like UTM are best for this analysis. 
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i. If the coordinate system is not correct, click Properties…-> click the 

Coordinate System tab-> select Use Export Coordinate System-> click 

Change… 
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 Use the drop down menus to select the appropriate coordinate system and 

associated properties-> click OK. 

iii. In the Properties window, click the Position Filter tab. Under Include 

Positions That Are, ensure that Uncorrected is checked. 
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 This will export all features, including those which could not be 

differentially corrected.  

 This setting is saved, but, since missing this step could result in the loss of 

data, it is a good idea to check this setting about once per day that you 

export data. 

e. Click OK to export the file or files. 

f. The Export Completed window appears when the export is complete. This 

window shows how many features were in the initial COR file(s), and how many 

features were exported. There should be the same number of features before and 

after export. You can click More Details… to see exactly which files were created 

and where they are located in a log file similar to the log file created in the data 

transfer process. This text file is saved to the same folder as the exported files. 

Click Close when you are finished viewing the Export Completed dialog. 

3. Each shapefile is composed of a number of files that are readable by ArcGIS. Use 

ArcCatalog to move or copy the shapefiles into the appropriate GIS workspace if you 

did not save them there in step 2b above. Pre-processing can now begin. 
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SECTION II: PRE-PROCESSING 

 

 This section describes the necessary steps that must occur before the GRAIP 

toolbar analysis can begin. The DEM must be clipped to the right watershed, a new set of 

files must be created with the GRAIP Preprocessor, the errors generated during the 

creation of those files must be corrected, and the road lines must be made to both reflect 

the actual shape of the road and be free of excess zigzag. 

 

 

Preparing the DEM 

 

You need to obtain the DEM and HUC boundaries first. Part of these instructions 

can be applied to any DEM that needs to be clipped to a polygon. 30 meter resolution 

DEMs have proved to be best for this analysis. Rectangular coordinate systems such as 

UTM are best. 

The extent of the DEM should encompass the smallest full watershed that 

contains all of the roads (up to the headwaters and down to the mouth). However, in some 

instances, entire watersheds are too big to be practical (the maximum size for TauDEM 

and SINMAP is 7000 x 7000 grid cells, and smaller sizes may hang up or crash). The 

final DEM should at least encompass all of the necessary roads, the complete sub-

watersheds that contain those 

roads, and all sub-watersheds 

that contain runoff from these 

roads until all surface flow 

paths converge. If there are 

two roads in two sub-

watersheds of, for example, 

the large Alsea River 

watershed on the central 

Oregon coast, the HUCs that 

encompass those sub-

watersheds that contain those 

two roads are necessary, and 

so are any other HUCs that 

encompass their drainage to 

the Alsea River, and those that 

encompass the Alsea River in 

between those sets of 

drainages (Figure 13). Some 

of the steps below might not 

be necessary, depending on 

the size of the watershed and 

size of the HUCs. 
Figure 13. The Alsea River watershed DEM with the necessary 

HUCs overlaid in yellow and the necessary roads in red.  Each of 

the HUCs present covers part of the path water would take from 

each road on its way to the mouth of the Alsea River. 
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1. Open ArcMap and add the DEM and the HUC boundaries. 

a. Go to the Windows Start menu-> Programs-> ArcGIS-> ArcMap. 

b. In ArcMap, go to the Main Menu-> File-> Add Data…-> navigate to the location 

of the DEM-> click Add. The DEM is added to ArcMap, and is displayed in the 

Table of Contents. Do the same for the HUC boundaries. 

i. You can also use the Add Data button in the Standard toolbar, in the red box, 

above. 

2. Make sure the HUCs and the DEM are in the same projection as the shapefiles of the 

field data. It’s good to make copies of both with ArcCatalog before changing their 

attributes. 

a. Right-click in the layer name in the Table of Contents-> click Layer Properties to 

open the Layer Properties window for each layer-> Source tab-> scroll down to 

Spatial Reference, expanding the line if necessary. If the two layers have the same 

Spatial Reference as the shapefiles, move on to step 4. If they do not, or if one is 

undefined, proceed, even if both layers are overlapping in the map viewer window 

as expected. 
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3. It is important to use the correct method when projecting DEMs, because the wrong 

method will result in artifacts in the data that will cause errors. If the HUCs or the 

DEM are in the wrong projection, they should be projected or re-projected to the 

same coordinate system as the shapefiles. 

a. To project the DEM, open ArcToolbox-> Data Management-> Projections and 

transformations-> Raster-> Project Raster (see below). 

i. From the Project Raster window, 

 Under Input raster, click the drop-down menu and select the DEM. 

 If there is nothing under Input Coordinate System (optional), click the 

button to the right of that field-> Select-> navigate to the projection that 

you think the DEM is in-> click Add-> click Apply-> click OK. 

 Under Output raster, click the button to the left of the field-> navigate to 

the folder in which you wish to save the new projected DEM (probably the 

same place as the original DEM), and type a new name (such as demproj). 

Click Save. 

 Under Output Coordinate System, click the button to the right of the field-

> click Select, navigate to the appropriate coordinate system (same as the 
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shapefiles; UTM is under Projected Coordinate System-> Utm)-> click 

Add-> click Apply-> click OK. 

 Under Resampling technique (optional), click the drop-down menu and 

select BILNEAR. CUBIC will also work, but do not use NEAREST. 

 Under Output cell size (optional), type “30”. 

 Click OK. A new DEM that contains the same information as the original 

DEM is created. Use this DEM for the rest of this section. 

b. To project the HUCs or any other shapefile, open ArcToolbox-> Data 

Management-> Projections and transformations-> Feature-> Project (see below). 

i. From the Project window, 

 Under Input Dataset or Feature Class, click the drop-down menu, and 

select the HUCs shapefile. 

 If there is nothing under Input Coordinate System (optional), click the 

button to the right of that field-> Select-> navigate to the projection that 

you think the HUCs are in-> click Add-> click Apply-> click OK. 
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 Under Output Dataset or Feature Class, click the button to the left of the 

field-> navigate to the folder in which you wish to save the new projected 

HUC shapefile (probably the same place as the original HUCs), and type a 

new name (such as HUCproj). Click Save. 

 Under Output Coordinate System, click the button to the right of the field-

> click Select, navigate to the appropriate coordinate system (same as the 

shapefiles; UTM is under Projected Coordinate System-> Utm)-> click 

Add-> click Apply-> click OK. 

 Click OK. A new shapefile is created that contains the HUCs and is 

projected the same as the other shapefiles. Use this HUC layer for the rest 

of this section. 

c. The projected HUCs and DEM should be overlapping properly. 

4. Choose which HUCs you need. 

a. Add all of the roads you will be analyzing to ArcMap, as in step 1, overtop of the 

HUCs (which should be over top of the DEM). If the roads are mis-registered, re-

project them as you did for the HUCs in step 2, making sure to use the correct 

coordinate system.  
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b. Set the transparency of the HUCs layer to 35%. This is useful when determining 

the extents of each watershed and associated flow paths. 

i. Right click on the HUCs layer-> Properties-> Display-> type 35 in the 

Transparent box-> click OK.  

c. Select the HUCs that encompass the smallest full watershed that contains all of 

the roads (headwaters on down). Alternatively, select the only the sub-watersheds 

that contain the roads, along with the sub-watersheds containing runoff from these 

roads until all flow paths converge, as described above. 

5. Delete the rest of the HUCs. 

a. Go to the Editor toolbar-> Editor-> Start editing-> choose the folder with the 

HUCs if prompted. 

b. Use the Edit tool from the Editor toolbar (the arrow to the immediate right of the 

Editor menu, in the red box at right) to select all of 

the HUCs you don’t need (use the Shift key to select 

more than one). Go to the ArcMap Main Menu-> 

Edit-> Delete to delete those. 

c. Editor-> Save edits. 

6. Merge all of the HUCs into one. This is necessary for the buffering step (step 7). 
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a. Use the Edit Tool from the Editor toolbar  to select all the remaining HUCs at 

once (use Shift key; they should be the ones you want). 

b. Editor toolbar-> Target-> HUCs layer. 

c. Editor-> Merge-> any option will do-> 

click OK 

d. Editor-> Save edits. 

7. Buffer the new single HUC. This ensures 

that the end product DEM will have the 

entire necessary watershed. It expands the 

HUC feature over the ridge-tops separating 

the larger watershed from its neighbors. 

a. Use the Edit Tool from the Editor 

toolbar to select the single HUC 

feature. 

b. Editor-> Buffer…-> enter 500 m, or 

rough equivalent-> hit Enter key. 

8. Extract the DEM. This final step results in a new DEM that is the shape of the HUC, 

ready to be processed for GRAIP. 

a. ArcToolbox-> Spatial Analyst-> Extraction-> Extract by Mask. Enter the DEM as 

Input Raster, the now merged and buffered HUC layer as Input raster or feature 

mask data, and an appropriate location and name for the new extracted DEM 

(probably the same folder as the original DEM; any eight-character or fewer name 

will do, but it should be clear which is the extracted DEM). Click Compute. 
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Preprocessing Shapefiles 

 

  The Preprocessor has two functions. It creates the GRAIP file structure, and it 

checks the incoming data for the most common errors. Preprocessing creates a single 

shapefile with all of the drain points, called DrainPoints, and one with all of the road 

segments, called RoadLines. It also creates a single database with all of the data, and 

relates the correct DEM, DrainPoints, RoadLines, the database, and, later, the stream 

network shapefile to each other under a new file with a .graip extension. This .graip can 

only be opened with the GRAIP toolbar in ArcMap. In total, eight files are created, not 

including the multiple files that make up one shapefile (FileName.graip, DrainPoints.shp, 

RoadLines.shp, FileNameDP.log, FileNameRD.log, FileName.mdb, FileNameshpdp.txt, 

and FileNameshprd.txt; see Figure 14). The log files are created to identify RoadLines 

and DrainPoints that may have insufficient or erroneous data values. 

 When the Preprocessor builds the database for the input data, it references another 

database file called GRAIP.mdb (located in C:\Program Files\GRAIP\graip db), which 

has attributes that must match up with the attributes in the drain point and road lines 

shapefiles. The attributes in those shapefiles are originally input in the field GPS unit 

based on a particular data dictionary. Essentially, in order for everything to match up 

correctly at this step, the data dictionary used for field collection and the GRAIP.mdb file 

must match. There are three main data dictionary-GRAIP.mdb pairs currently used, all of 

which are available on the GRAIP website 

(http://www.fs.fed.us/GRAIP/downloads.shtml). The data dictionaries are INVENT4_2, 

INVENT5_0, and INVENT5_0_W; INVENT 5_0 is best for most purposes, as of 

December 2010. 

 When you download the GRAIP Database Update from the above website, you 

will have a set of database files (extension .mdb) all in one zip file. Unzip the contents to 

C:\\Program Files\GRAIP.  It should replace the \graip db folder.  This will leave GRAIP 

set up with its original database, ready to work with current data.  There is a backup of 

this original database in the \Original folder.  The updated database for Legacy Roads 

projects is in \graip db\GRAIP Update LegRds (using INVENT5_0). The update for 

watershed studies (using INVENT5_0_W) is in \graip db\GRAIP Update Wtrshd.  If you 

are going to be working with data collected with the updated (both INVENT5_0) data 

Figure 14. The files created by the GRAIP Preprocessor, not including 

DrainPoints.shp and RoadLines.shp. 
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dictionaries, then copy (don’t move) the appropriate GRAIP.mdb file to the C:\\Program 

Files\GRAIP\graip db folder, replacing the file that is there. Once data is imported via the 

GRAIP Preprocessor, you can work with the resulting .graip files regardless of which 

GRAIP.mdb is in the C:\\Program Files\GRAIP\graip db folder. 

 Before you begin this step, ensure that the correct GRAIP.mdb will be used in the 

Preprocessor utility. 

 

1. Open the GRAIP Preprocessor 

a. This is a separate program, installed with the GRAIP Toolbar and found in the 

GRAIP folder under Programs in the Start menu. 

2. Create a new .graip file 

a. Under Project File, click the {…} button, navigate to the folder with your 

shapefiles or wherever you want to save the .graip and other created files. 

b. Name the file with something relevant. Do not use spaces. Click OK. FileName is 

used here to refer to the .graip, etc. 

3. Select the DEM 

a. Under DEM File, click {…}, navigate to the desired clipped DEM, referred to 

here as just “dem” (it should be in the same folder in which you intend to save the 

TauDEM-created files, discussed previously). Double-click dem, select sta.adf, 

and click OK. 
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b. If you don’t have the DEM, you can still correct errors. For this step, use a 

dummy DEM (any DEM). You will have to re-preprocess the data with the 

correct DEM before running GRAIP. 

4. Add the road shapefile(s), and the drain point shapefiles. 

a. Under Road Shapefiles, click Add. Navigate to the location of the ROAD 

shapefile(s), select them, and click OK. 

b. Under Drain Points Shapefiles, click Add, Navigate to the location of the drain 

point shapefiles, select all of the drain point shapefiles, and click OK. There are 

nine possible drain point shapefiles, but not every study will have them all. They 

are BBASE_DI, DIFF_DRA, DTCH_REL, EXCAV_ST, LEAD_OFF, 

NON_ENGI, STRM_CRO, SUMP, and WATER_BA. 

c. You can add more than one shapefile with the same name, as if you imported, 

corrected, and exported the shapefiles in two batches. In this case, the second (or 

even third or fourth) set of shapefiles should be in a separate sub-workspace in the 

same workspace as the rest of the shapefiles. 

5. Click Options, ensure Step by step and Manual resolution of invalid/missing data 

values are selected in the Processing field, and click OK. These options ensure that 

you will catch any errors in the next step. You may also change the location of the 

error log files in this step, but that is not generally necessary. 
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a. If you choose Uninterrupted in the Processing field, all defaults will be used, and 

you will have no opportunity to specify what actions to take, where appropriate. 

This is rarely a good idea. 

6. Click Next. At this point, all of the files that are created by the preprocessor have been 

created, except DrainPoints.shp and RoadLines.shp. The next steps import the drain 

points and road shapefiles. 

7. A screen appears with the heading Import Drain Point Shapefile: 1 of X (X is the total 

number of drain point shapefiles that you are importing). You can see which file is 

being imported, which Drain Point Type the preprocessor thinks it is, and the Target 

and Source fields that go with that drain point type. Generally, these are all correct, 

and no input is needed. However, it is a good idea to check to make sure all of the 

target and source fields match up properly. If they don’t, you can select a match from 
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the drop-down menu that appears under the Matching Source Field when you click on 

a property. If you have the latest version of GRAIP and the latest data dictionary in 

the field, this should not occur. If the data dictionary has been modified, the incoming 

data will have unexpected values, and the Preprocessor will not be able to 

automatically import the data into the GRAIP geodatabase structure. When you are 

sure everything matches, click Next. Repeat this process for all drain points.  

a. The road lines are similar. 

b. If there is an undefined value in a drain point or road line, such as if a property 

exists in the data dictionary in the field, but not in GRAIP, the Define Value 

dialog appears. For example, before the last update, in the STRM_CRO shapefile, 

the ChannelAngleID > 75 degrees did not match that in the GRAIP data 

dictionary, because the GRAIP data dictionary did not have a space (so it is >75 

degrees), and this produces an error. If you are using the wrong version of 

GRAIP.mdb, this dialog box will appear a lot. 

i. You have three options, Use default value, Reassign this value in definitions 

table, and Add new entry to definitions table. Select the appropriate choice and 

click Ok. Generally, Add new entry to the definitions table is most appropriate. 

c. If there are CTime fields in the ROAD shapefile that have anything entered in 

them that is not a valid 24-hour time with four digits (e.g. 0745, 0959, 1919, etc.) 
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or 999, then the Preprocessor will freeze during the Import Road Lines Shapefile 

step. Examples of invalid CTime entries include: 9999, 9130, 930, 34, blank cell. 

i. If this happens, you must find the errant CTimes and edit them so that they are 

valid. Add the ROAD shapefile in which the error occurs to ArcMap, and use 

the layer’s attribute table to find and edit the errors. See the instructions for 

Editing Data Errors for more information. 

8. Preprocessing is now complete. The FileNameDP.log and FileNameRD.log files, 

located in the same folder as FileName.graip, contain the errors that the preprocessor 

found, used in the next step. 

9. In the next step, you will locate and fix any errors. When you re-preprocess the data, 

after the errors are corrected, and any time the DEM used does not change (including 

if you change which shapefiles are used, so long as the DEM remains the same), you 

can just select the already created Project File (FileName.graip) on the first screen, 

and click Next. Click OK when asked if you want to delete the DrainPoints, 

RoadLines, and FileName.mdb files. Proceed as before. You will have to go through 

any Define Value dialogs again. If you change the DEM, you must use a new .graip 

(e.g. FileName2.graip). Again, click OK when asked if you want to delete the 

DrainPoints, RoadLines, and FileName.mdb files. If no points have been added or 
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deleted from the original shapefiles, the preprocessor assigns the same 

GRAIPDID/GRAIPRID number to each point as it did the first time. 
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Editing Data Errors 

 

The error logs generated by the GRAIP Preprocessor (FileNameDP.log and 

FileNameRD.log) contain the drain points and road lines that are not associated with a 

valid CTime/CDate/VehicleID combination. An error is logged for a drain point if its 

CTime/CDate/VehicleID combination is not referenced to any road segment. An error is 

logged for a road line segment if none of the entered CTime/CDate/VehicleID 

combinations correspond to a drain point (i.e. if there are two flow paths, and only one is 

entered incorrectly, there will not be an error in the road line, though the associated drain 

point may generate an error). These errors must be corrected before running GRAIP. 

There are four main kinds of errors. The first are data entry errors, where the 

CTime/CDate/VehicleID in the road line does not match those in the desired drain point. 

Drain point data are generally correct, because their CTime/CDate/VehicleID 

combination is automatically generated. These errors occur because the 

CTime/CDate/VehicleID combination in the road line was incorrectly entered in the field, 

and are usually rounding errors (e.g. the CTime was rounded from 01:34:32 to 1334 

instead of 1335, which is correct). 

The second main kind of errors are real orphan drain point errors, where the drain 

point in the field was collected, but was not used to route water. This is intentional; some 

“drain points” do not actually drain any water anymore. Water bars on diffuse roads, 

completely blocked ditch relief culverts, and stream crossings that do not directly drain 

water are all examples of this. Nothing is done to correct these errors because they are 

intentional. 

There are computer and program errors. These are relatively rare. There is a 

known error in the program that causes it to improperly round off the last minute of the 

hour from the drain point CTime to a 60 instead of 00 (so 12:59:45 becomes 1260 instead 

of 1300). Another example of a computer/program error is the -6 or -7 hours error, where 

the CTimes in a certain drain points shapefile will all be behind by 6 or 7 hours (so 

10:45:20 becomes 4:45:20 or 3:45:20). This is rare. 

Finally, there are point or road segment collection errors, where a drain point or 

road line was unintentionally collected, or collected twice, and then not deleted, in the 

field. This is uncommon. 

In order to check and fix these errors, the ROAD and various original drain points 

shapefiles must be edited so that every road has a matching CTime/CDate/VehicleID, and 

every drain point that routes water in the field is matched to a segment of road. Note that 

the shapefiles generated by the GRAIP Preprocessor (DrainPoints.shp and 

RoadLines.shp) are not edited. In order to make those files match the edited originals, 

you have to re-run the GRAIP Preprocessor on the corrected original shapefiles.  

Note that CTimes in the ROAD layer are in 24-hour format, rounded to the 

nearest minute, and without colons (so, 1537 means 03:37:25, 03:36:48, 03:37:30 etc.). 

Note that xx:xx:30 rounds down, while xx:xx:31 rounds up. The CTimes in the original 

drain point are in 12-hour format, with seconds. The CTimes in the original drain point 

must be in the format xx:xx:xx, or GRAIP won’t know what the CTime means. 

There are four columns in each error log (Figure 15). “GRAIPDID” contains the 

GRAIPDID number that corresponds to that feature in the DrainPoints table, and 

“GRAIPRID” contains the GRAIPRID number that corresponds to that feature in the 
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RoadLines table. “Type” or “Drain Type” is the feature type (i.e. Water Bar, Stream 

Crossing, Road Line, etc.). “Error Message” describes what the problem is (such as 

“Orphan drain point;” this does not mean the drain point is an intentional orphan!). 

“Action Taken” describes what the Preprocessor did to fix the problem. This field usually 

says “Nothing,” unless the Define Value dialog corrected an error in that point. If that is 

the case, no further action is needed for that point.  

The fundamental goal of error checking is to ensure that each flow path on each 

road segment drains to the appropriate and valid drain point. Fixing the errors from the 

error logs is a bit like being a detective. You have to use the clues in the data to figure out 

what is happening on the ground. Clues include the comments made by field crews, the 

type of drain and flow path, photos, the direction the flow path is moving (discernable 

from the DEM and by which end of a road segment the associated drain point is located 

on), etc. Sometimes, a solution for one drain point or road line error solves more than one 

problem. Often, fixing a drain point also fixes a road segment. This might seem pretty 

complicated, but it gets much easier once you do it once or twice.  

 

1. Use the Windows text editor to view the error log files 

(FileNameDP.log and FileNameRD.log). Print them for easier 

reference (they can be combined into one page, but don’t save them 

that way). 

2. Open ArcMap-> File-> Add Data…-> navigate to the folder with 

the original shapefiles (ROAD, DIFF_DRA, etc.)-> select all 

original road lines files and drain points files (but not non-drain 

point or road line files, such as END_RD)-> click Add. Also add the 

RoadLines and DrainPoints shapefiles generated by the GRAIP 

Preprocessor and the PHOTO shapefile; these are used for 

Figure 15. The error log for the RoadLines table with each of the four columns noted. 
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reference. Arrange the RoadLines and DrainPoints layers under the rest of the layers 

in the Table of Contents window. 

a. Label the RoadLines and DrainPoints layers for easier reference. Right-click the  

layer-> Properties-> Labels tab-> check Label features in this layer-> make sure 

GRAIPDID or GRAIPRID is selected in the Label Field drop-down menu-> click 

Symbol-> Properties…-> Mask tab-> select  Halo-> Click Symbol to change the 

color of the halo-> click OK until you are out of the Properties window. Labeling 

makes it easier to see when there are multiple drain points close together or on top 

of one another. 

3. Right-click the DrainPoints layer in the Table of Contents-> Open Attribute Table. 

The GRAIPDID and FID columns correspond to the “GRAIPDID” column in the 

error log. This also applies to the RoadLines Attribute Table and error log. 

4. For each point in the drain points error log, find the corresponding point in the 

Attribute Table (same GRAIPDID number). 

a. Look at the GRAIPDID number on the error log. Find it in the Attribute Table 

and click the grey box to the left of the FID column to select that point. 

b. Zoom in on the selected point. 
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i. There are two ways to do this. Either use the Zoom In tool from the ArcMap 

Tools toolbar, or go to the ArcMap Main menu-> Selection-> Zoom To 

Selected Features. You may have to use the Fixed Zoom In button from the 

Tools toolbar to get closer. Zoom To Selected Features is available as a button 

in the Tools toolbar (see the Introduction). Once zoomed into the extent that 

you want, you may want to use Pan To Selected Features. 

c. Use the Identify tool from the ArcMap Tools toolbar to select the drain point from 

the original shapefile (e.g. SUMP) that directly overlays the selected (and labeled) 

point from the DrainPoints layer. 

i. Click the Identify tool, and click the selected point (which is from the 

DrainPoints layer). Since the point from the DrainPoints layer is directly 

underneath the point from the original shapefile, and the Identify tool selects 

the top-most layer by default, the original shapefile is selected. This also 

applies to the RoadLines and its corresponding original shapefile (ROAD). 
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d. Alternatively, you may find it easier to use the Attributes window from the Editor 

toolbar. 

i. After you have begun your editing session, go to the Editor toolbar-> click the 

Attributes button-> pick the Edit Tool from the Editor toolbar (the arrow to the 

immediate right of the Editor menu)-> click on a feature (drain point or road 

line shapefile). 

ii. The attributes of that feature appear in the Attributes window. You can edit 

the attributes by clicking in the Value column and typing. 

iii. Remember to continue to save your edits. 

5. Now you must decide which type of error is occurring at this point and how to fix it. 

a. In the Identify box, look next to the COMMENTS field (you may have to scroll 

down). If the comment says “orphan,” “orph,” “doesn’t drain,” etc., this is most 

likely an intentionally orphaned point. The latest version of the data dictionary 

includes a new field in each applicable drain point where crews specify whether 

that drain point is an orphan. This makes it easier and faster to find intentional 

orphans in the office. Note this on the error log hard copy, and move on to the 

next point in the log. 
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b. Note the CTIME in the Identify box of the original drain point shapefile. Use the 

Identify tool in the same way to look at the surrounding road segments (in the 

original shapefile; ROAD). Remember that each road segment has two flow 

paths. 

i. If both surrounding road segments have CTimes in both flow paths, check the 

next drain points down the road on both sides of the problem drain point to 
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see if those drain points have the same CTimes as those listed in the road 

segment. You may have to check more than one set of CTimes to be sure. If 

all road CTimes are accounted for (i.e. all flow paths drain somewhere that is 

not the drain point in question), the drain point error is probably an unlabeled 

intentional orphan. 

 Label the orphan. Look in the Identify box of the drain point in question 

and note its FID. Editor toolbar-> Editor-> Start Editing. Open the 

attribute table for that drain point type, scroll to that FID. Select that row 

and scroll over to the COMMENT column. Click that field, and type “true 

orphan,” “unlabeled in field orphan,” “orphan,” “orph,” etc. Go to Editor-

> Save Edits. 

ii. If both surrounding road segments have CTimes in all used flow paths, but not 

all CTimes are accounted for in nearby drain points, the errant CTime is 

probably supposed to be the CTime from the problem drain point. Since this is 

usually a rounding error, the CTime in the road and that in the drain point will 

probably be within a minute of each other (e.g. 1756 and 05:56:32). One 

common rounding issue is mentioned above (the 00 = 60 error). Another is the 
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rounding of drain point CTimes that end 

in 30 (i.e. 03:15:30pm rounded up instead 

of down). 

 Similar to above, use Identify to find 

the FID of the road, find that FID in 

the Attribute Table for ROAD, and 

select it. Scroll over to the CTime 

columns and enter the correctly 

rounded CTime from the drain point 

into the cell with the incorrectly 

rounded CTime. Save the edit. 

 This is where you might notice the rare - 6 or -7 hours error. If this is the 

case, check the rest of the drain points of that type. The easiest way to deal 

with this error is to verify that all drain points in a particular shapefile are 

affected (they usually are), and then change them in the drain point 

attribute table all at once using the same method as above. A side effect of 

this error can be that there are duplicate drain points, which will be noted 

in the error log. As such, if this error is discovered, it is best to fix it, and 
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then re-run the GRAIP Preprocessor, so that a new error log is generated 

without duplicates or the many -6 or -7 hours drain points. 

 Rember that CTimes in the ROAD layer are in 24-hour format, and that 

xx:xx:30 rounds down, while xx:xx:31 rounds up. Remember that the 

original drain point must be in the format xx:xx:xx, or GRAIP won’t know 

what the CTime means. 

iii. If both surrounding road segments do not have CTimes in all used flow paths, 

the problem drain point is probably the missing CTime in the ROAD. Check 

to see that the drain point type makes sense with the flow path. For example, a 

flow path of ditch would probably drain to a ditch relief culvert or stream 

crossing, but not a diffuse drain. There are exceptions to any rule like that, but 

there should be a comment in the road or drain point to describe those 

situations. 

 If the drain point in error appears to be the missing CTime from the road 

line, enter the correct CTime into the ROAD Attribute Table. As above, 

use Identify to find the FID of the road, find that FID in the Attribute 

Table, and select it. Scroll over to the CTime columns and enter the 

correct CTime from the drain point into the missing space. Save the edit. 

 If some other drain point appears to be the missing CTime from the road 

line, enter it in the missing place in ROAD. The errant drain point may be 

an intentional orphan, described above. The other drain may or may not be 

in the error log on its own (if it drains another road segment, it won’t be in 

the error log). 
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c. Some other errors include those in CDate and VehicleID. These are fairly rare, 

since neither of those fields are usually changed from default in the field. If it is 

not clear why an error is occurring from looking at the CTimes, check these 

fields, and edit as above the incorrect entry. Both fields are in the Identify box. 

i. CDate errors can occur when a drain point from one day is referenced the next 

day. Change the CDate in either the road segment or the drain point, 

whichever is easier. This can get messy if more than one road segment drains 

to that point, or the road segment has two flow paths, because all drain points 

associated with the road segment must have the same 

CTime/CDate/VehicleID combination. 

ii. VehicleID errors can result in “Duplicate DrainID: xxxxxxxxx” (where the x’s 

are numbers) errors in the data log. This happens if two crews collected a 

point at the same time on the same day, but one of the crews accidentally 

entered the VehicleID of the other crew. 
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d. The last kind of error will present itself as a drain point or road line with all 

default properties, as a drain point of the same type, in the same location, and with 

the same properties as another (except CTime/CDate/VehicleID, which are 

automatically generated), or as a road line in the same place and with the same 

properties as another. A field crew may have began to collect the wrong drain 

point or road line, and then not deleted it, or they may have collected the same 

drain point or road line on two different days. There is a possibility that this was 

intentional, but duplicates should be deleted in any case, and resulting errors 

fixed. If the same point or line was collected on two different days, there is a 

possibility of generating CTime/CDate/VehicleID errors. 

i. Delete duplicate or unintentional drain points. Use the Edit Tool from the 

Editor toolbar to select the erroneous point or line, being sure that you have 

selected the correct point or line, and then, from the Main Menu-> Edit-> 

Delete. Save the edits 
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ii. Be sure to correct any further errors generated by deleting duplicate points, as 

above. 

6. Repeat the above steps for the rest of the errors in the log, noting in the error log hard 

copy what has been done to fix the problem (or if the point is an intentional orphan), 

and saving the edits. 

7. Repeat the above steps 3-6 for the ROAD and RoadLines layer. There are no real 

differences in technique. Often, fixing a drain point error also fixes a road error. Be 

sure to edit the ROAD layer or the original drain points layer. 

a. Note that in the road lines error log, there are two “Types” The first is “Default” 

and the second is “Road Line.” Note that the “GRAIPRID” is the same for each. 

There is no real difference between the two; for example, GRAIPRID 8 next to 

“Default” refers to the same road line and error as GRAIPRID 8 next to “Road 

Line.” This does not mean that there are two errors. 

8. If only one flow path in a road line does not have a CTime (i.e. the CTime is entered 

as 999), GRAIP will assign to it the CTime of the other flow path that does have a 

CTime. This can cause water to be routed to the wrong drain point. Do a final check 

on the ROAD shapefile to ensure that there are no single orphan flow paths. 

a. Open the Attribute Table for the ROAD shapefile-> right-click the column 

heading to the CTIME1 column-> click Sort Descending. If there are any entries 

that are 999, then those rows will be moved to the top. You should figure out why 
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those entries are not valid CTimes, and fix them so that they are. Do the same for 

the CTIME2 column. Save the edits. 

9. When all errors in the error logs and ROAD shapefiles have been addressed, save the 

edits, and then go to Editor-> Stop Editing. Close ArcMap, or open a new map file (in 

the ArcMap Main Menu, go to File-> New…). There is no need to save the map file 

because the edits made have already been saved in each edited shapefile. 

10. Re-run the GRAIP Preprocessor, as described above. Look at the new error logs to 

verify that the only errors generated for the drain points are intentional orphans (if 

any). If you did not delete any duplicate or unintentional drain points or road lines, 

the GRAIPDID/GRAIPRID numbers assigned to each point or line by the 

Preprocessor the first time will correspond to the same points or lines the second 

time. There should not be any errors in the road lines error log, because road line 

errors are only generated when the road segment has no associated drain points, 

which cannot happen on the ground. Print the new error log, and save both copies for 

future reference. If you have to re-run the Preprocessor in the future, you can compare 

the new error log to the error-free log to ensure that no new errors were generated. 
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Straightening Road Lines 

 

 Commonly low quality GPS satellite location points due to topography and 

canopy cover result in inaccuracies in the point and line location data. This is generally 

not a problem with drain point data, because each drain point is an average of 60-100 or 

more GPS positions. However, road lines are composed of a series of single positions 

(the vertices) connected in order of collection. As such, what is a fairly small error in a 

drain point becomes a larger error in the road line. This shows up as zig-zaggy road lines. 

If the crew stopped moving, but did not stop collecting data, there will be a closely knit 

group of vertices and road lines that are jumbled; these are referred to as rat’s nests 

(Figure 16). 

Zigzags and rat’s nests in the road add length to the road, resulting in inaccuracies 

with the final data. A rat’s nest that spans a small area can contain a lot of extra length. 

Additionally, zigzags and rat’s nests that stray outside of the road’s edges can result in 

inaccurate road slope results. Finally, rat’s nests and zigzags get in the way of seeing and 

easily understanding how the road drains. For these reasons, rat’s nests must be 

eliminated, and zigzags must be straightened. After all of that, the road lines must be 

compared to an aerial photo to ensure all details of the road’s course are included. 

Figure 16. 

Examples of a 

rat's nest (left) and 

a section of very 

zig zaggy road 

(right). 
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 In order for the length data to be as accurate as possible, there should be a 

minimum of zigzag, and no rat’s nests, at the end of the straightening process. 

Additionally, the mapped road lines should always be within the real road’s edges (Figure 

17). Roads can often be seen on aerial photos. The most important thing when 

straightening road lines is that they are consistent. Road lines do no need to be perfect. A 

good guideline for editing road lines is to try to create smoothly curving segments that 

have a high frequency amplitude of less than six meters. Most forest travel surfaces are 

about six meters wide. Remember that roads are generally smoothly changing features. 

If you use a U.S. Forest Service computer, you can access background aerial 

photos from the USFS Image Server, which can be found on the web, with instructions, at 

http://fsweb.rsac.fs.fed.us/imageserver/imageserver.html. Registration problems with the 

Image Server are often the result of your data not being projected. Open a new map file in 

ArcMap, add a piece of data that you know is correctly projected, like the DEM, add the 

image, and then add the rest of the data, as below. You may have to actually re-project 

the data, as above in step 3b of the Preparing the DEM instructions. 

If the road lines are not complete or missing critical data that you cannot infer, or 

if drain points are likely missing, have the field crew return to the location to recollect 

data or otherwise clear up the confusion. 

 

1. Open ArcMap, and add relevant data, described above in step 2 of the Editing Data 

Errors instructions. 

Figure 17. Before (white dashed 

line) and after (red solid line) the 

road line straightening process. 

Note that the straightened road line 

connects all drain points and is 

within the bounds of the road on 

the background image. 
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a. Relevant data are all original road lines and drain points (ROAD, SUMP, etc.). If 

you have a previous version of the road that has already been corrected (as in pre-

and post- treatment for the Legacy Roads project), add it as well. 

b. A background image can be added now or later, but it will slow things down too 

much if the layer is left visible. 

2. Start editing (Editor toolbar-> Editor->Start Editing). Zoom in on the end of a road 

(1:500 to 1:2000 are good scales for this level of editing). There are three ways to edit 

a line. If there is zigzag that is composed of only a few points, you can delete or move 

those points until the road line is straight again. If there is a rat’s nest at the end of a 

line, you can use the Split tool to divide the line in two and delete the bad part and 

recreate the line in the correct location. If the zigzags are composed of many points, 

there are a series of steps you can take using the Advanced Editing tools that greatly 

simplify the process. See steps 3 to 6 below. 

a. Remember that the drain points are usually fairly accurately located. Use them to 

connect one road line to another, like connect-the-dots. 

b. The ends of the road lines should be right on top of the drain point, so it is a good 

idea to use snapping. All drain points should be at the end of the road line, except 

some orphans and diffuse drain points, which may or may not be at the end of the 

line. 

i. Snapping allows for accurate placement of feature parts relative to other 

feature parts. When snapping is turned on and set up for this process, road line 
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vertices that you are moving will jump directly on top of other drain points 

and the end of other road lines when you move the vertex close enough. 

ii. To set up snapping for this purpose, click Editor in the Editor toolbar-> click 

Snapping....  

 In the window that opens, check the boxes in the Vertex column for each 

of the drain points, and check the box(es) in the End column for all of the 

road line shapefiles. Close the window. 

iii. As you move along a road line, be sure to snap the end points of each road 

line segment to an appropriate drain point or end of adjoining road line (e.g. at 

the top of a hill). If there are multiple drain points in the same area, you can 

either pick one of the drain points (not an orphan) to snap both road lines to, 

or snap the road lines to each other in the middle of the drain points. 

3. To delete individual vertices: 

a. Pick the Edit Tool from the Editor toolbar (the arrow to the immediate right of the 

Editor menu). Double-click the road line to display its vertices.  
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b. Right-click an errant vertex. This displays some options, including Delete Vertex. 

Select that option. 

c. You can also insert a vertex on a line from the same menu if you right-click on a 

portion of line without a vertex. 

d. It’s OK to delete the red end-point vertex—the next-to-the-end-point vertex 

becomes the new red end point vertex. 

e. A faster way to insert and delete vertices is to right-click the errant vertex or road 

line and press the I key for Insert Vertex or the D key for Delete Vertex. 

4. To move a vertex, double-click the line with the Edit Tool. Move the Edit Tool over 

the vertex that needs to be moved. Click and drag it to its new location. 
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5. To use the Split Tool to delete a rat’s nest: 

a. Select the line with the Edit Tool (you may want to show the vertices by double-

clicking the line), select the Split Tool, and click on the line to one side of the rat’s 

nest or portion of very bad line. You have now divided the single line with a 

certain set of properties and a certain FID number in the Attribute Table into two 

lines with the exact same properties. One line retains the original FID number, 

and the other line is assigned a new number. 

b. Use the Edit Tool to select and delete the rat’s nest or portion of very bad line.  

i. Click on the rat’s nest or portion of very bad line to select it. In the ArcMap 

Main Menu, go to Edit-> Delete, or hit the Delete key on your keyboard. 

c. After a section of road is deleted, you must re-construct that portion of the line by 

moving the nearest vertices to fill the gap, as in step 4. 

d. Save the edits frequently. 
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e. In order to make sure you haven’t deleted anything that shouldn’t have been 

deleted, or left something that should have been deleted, check the Attribute Table 

for the ROADS layer before you begin, and note how many table entries there are 

(in the bottom-middle of the table window, Records (blank out of total Selected). 

i. Don’t use the largest FID number to see how many table entries there are, 

because these numbers get changed during the line splitting process. 

ii. If there are too many records at the end of the line straightening process, sort 

the table by CTime and look for duplicates. If there are too few records, look 

for gaps in the road. Note when there are extraneous road segments already 

present that get deleted as you go along, because these will reduce the total 

number of records (this is rare; see also step 5d of the Editing Data Errors 

instructions). 

6. If the road line is very erratic and there are many vertices, the best method requires 

the Advanced Editing tools. 
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a. To turn on the Advanced Editing tools, go to the Editor toolbar-> Editor-> More 

Editing Tools-> click Advanced Editing. 

b. With the Edit tool, double-click the road line you wish to edit to display its 

vertices. 

c. Go to the Advanced Editing tools-> click Generalize-> next to Maximum 

allowable offset, enter a very large number such as 100 -> click OK. The road line 

is reduced to two vertices. 
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d. Insert and move into place two to four vertices as above so that the road line very 

generally follows the curve you want it to. Deciding where to do this becomes 

easier with practice. 

e. With the road line vertices displayed, go to Advanced Editing tools-> Smooth-> 

next to Maximum allowable offset, enter a number in the range of five to 15-> 

click OK. The road is now a smooth curve without straight connect-the-dots style 

segments. Deciding which number to enter becomes easier with practice. 

f. With the road line vertices displayed, go to Advanced Editing tools-> Generalize 

-> next to Maximum allowable offset, enter a small number in the range of one to 

five-> click OK. The road line is returned to being connect-the-dots straight, 

which allows easier moving of vertices if necessary. Deciding which number to 

enter becomes easier with practice. 

g. Save the edits frequently. 
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h. You may find that it is easier to do this with a background image. See the next 

step (step 7). 

i. You may find that this method is preferable for all road lines in some areas. 

7. If you haven’t added a background aerial photo yet, do so now. If you have, turn the 

layer on. 

a. If you have a 1 m resolution image, 1:1600 or so is a good scale. If you zoom in 

much closer than that, the image becomes blurry and you can’t tell where the road 

is located. 

8. Check to make sure the road on the photo is registered the same as the road line from 

the data. 

a. If the road is not registered correctly, you can still use the photo as a guide, but 

keep the apparent offset in mind as you go.  

b. Sometimes, trees and shadows block the view of the road on the photo. Check for 

photos taken at a higher sun angle. You may have to interpolate and guess in 

those areas. Some roads are not visible at all on aerial photos. 

9. Check to make sure the road line from the data follows the road on the photo, and is 

contained within the width of the road on the photo. 
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a. Start at one end of the road, and work your way along. 

b. Often, a road line that has been extensively edited because of abundant zigzags 

and rat’s nests will be off the road on the image in between drain points. 

c. Sometimes, even drain points are off of the road. Usually, it’s only one drain 

point in a group of drain points that is errant. If the drain point is more than the 

road width away from the road, use the Edit Tool to select and drag the drain 

point back to the road. 

d. Save the edits frequently. 

10. Check the number of entries in the ROAD Attribute Table, as described in step 5e 

above. 

11. When finished, save the edits, stop editing and either close ArcMap or open a new 

map file, as in step 9 of the Editing Data Errors instructions, above. There is no need 

to save the map file, because the edits you made have already been saved to the 

shapefile itself. 

12. Re-run the GRAIP Preprocessor, as described above. This will generate RoadLines 

and DrainPoints shapefiles that reflect the changes made to the road lines. 

a. It is a good idea to look at the error logs once more to ensure nothing has 

changed. 

13. The actual GRAIP analysis can now begin. 
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SECTION III: RUNNING THE GRAIP MODEL 

 

 This section describes the steps that are taken to run the actual GRAIP model with 

the GRAIP toolbar. TauDEM  and SINMAP must first be run to generate files to be used 

by GRAIP. There are some initial steps that must be taken in the GRAIP toolbar and 

Hawth’s Tools before true analysis can begin. There are two main parts of the GRAIP 

process that must be competed in order, except for the Combined Stability Index. There is 

one further step related to fish passage barriers at stream crossings that you may or may 

not want to run, depending on the purpose of your study. 

 

 

Running TauDEM 

 

 TauDEM is used to generate a set of grids and shapefiles that are used by GRAIP, 

including the stream network shapefile (17 files in total). There are 13 grid files created 

by TauDEM (dem stands for the name of the DEM used): demfel, demsd8, demp, 

demang, demslp, demad8, demsca, demgord, demplen, demtlen, demsrc, demord, and 

demw. There are two shapefiles created by TauDEM: demnet, demw. The stream 

network shapefile (demnet) is associated with FileName.graip, and is added when the 

.graip is opened The last two files are demtree.dat and demcoord.dat. 

 TauDEM may take a long time to run, depending on the size of the DEM (the 

maximum gird size is 7000 x 7000 cells). The folder in which the DEM that is used is 

placed will be the folder in which all of the TauDEM-generated files are saved to. Later, 

this is the same folder in which SINMAP will create its folder. As such, it is a good idea 

to start with a fresh ArcInfo Workspace with only the DEM that you plan to use in it. 

TauDEM requires that the DEM name not be any longer than seven characters. The DEM 

should be projected to a rectangular coordinate system, such as UTM, rather than a 

geographic coordinate system, and should be about 30 m resolution. 

 

1. The projection for the DEM must be defined if it is not already. If it is defined, skip to 

step 2. 

a. Open ArcMap, add the DEM. 

b. Open ArcToolbox. 

i. ArcMap Main Menu-> Window-> ArcToolbox, or the button in the Standard 

toolbar. 

c. In ArcToolbox, go to Data Management-> Projections and Transformations-> 

Define Projection.  
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i. Under the Input Dataset or Feature Class, use the drop down menu to select 

the DEM. 

ii. Click the box to the left of the Coordinate System field-> Select-> navigate to 

the projection that that the DEM is in, click Add, then Apply and OK. 

iii. Click OK. The projection is now defined. This works for any GIS file. 

d. Close ArcMap or open a new map file. You don’t have to save the map file 

because the changes are saved automatically. This will set the ArcMap viewer 

with the correct projection information before TauDEM is run. 

2. If you don’t have one already, create an ArcInfo workspace for the TauDEM (and 

later SINMAP) files. This should be done for every data set, even if multiple data sets 

share the same DEM. If you have done this, skip to step 3. 

a. Open ArcCatalog, and navigate to your 

working folder (see Appendix I for an 

example of a file system for GRAIP). 

b. Right-click-> New-> ArcInfo Workspace. 

Rename the new workspace with 

something obvious (Section I, Figure 8). 
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c. Navigate to the location of the clipped DEM. Copy it. 

i. Right-click the DEM-> Copy 

d. Navigate back to the new workspace and paste the DEM into it. 

i. Open the workspace folder. 

ii. Right-click anywhere in the folder-> Paste. 

e. Close ArcCatalog or navigate away from the new workspace. TauDEM and 

ArcGIS might get confused if the workspace they are modifying is active 

(currently being viewed) in ArcCatalog at the same time. 

3. Open ArcMap and add the clipped DEM with the projection defined from the 

TauDEM workspace to the viewer. 

4. It is best to do the rest of these steps one immediately after another. From the 

TauDEM toolbar-> Basic Grid Analysis-> Select Base DEM grid… 

a. Use the drop-down menu to select the DEM and click OK. 

5. Go to Basic Grid Analysis-> Full River Network Raster. You don’t want to run this 

step now, just adjust its parameters 
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a. Uncheck Check for Edge Contamination 

i. This will automatically uncheck Use D-Inf Contributing Area Grid as an edge 

contamination mask. 

b. Change the Threshold to 25 

c. Click Apply twice (to ensure it registers), then Cancel. 

6. Go to Basic Grid Analysis-> Do All. 

a. Double-check the default parameters and click Compute. 

b. This step produces 11 grids (demfel, demsd8, demp, demang, demslp, demad8, 

demsca, demgord, demplen, demlen, demsrc). 
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7. Go to Network Delineation-> Do All Network and Watershed Delineation Steps. 

a. Click OK when asked if it’s OK to delete the existing src output file. 

b. This step creates the last four grids and shapefiles (demord, demw, demnet.shp, 

demw.shp), recreates demsrc (which is why you are asked if the original demsrc 

can be deleted), and the last two files (.dat extension). 

c. Do not use an outlet point. 

8. Before proceeding, close ArcMap or open a new map file. This will allow for a fresh 

start for the next section. You don’t have to save the map file because grids and 

shapefiles are already saved on the hard drive. 
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Running SINMAP 

 

 SINMAP has its basis in the infinite plane slope stability model and produces 

raster grids that illustrate slope stability (shallow landslide risk) based on hillslope and 

specific catchment area at each DEM grid cell (Pack et al. 2005). It is usually necessary 

to calibrate SINMAP to known locations of landslides. The maximum grid size is 7000 x 

7000 cells. 

SINMAP must be run before the Mass Wasting Potential Analysis step and it is 

easiest to run it before proceeding further with the GRAIP model. It is necessary to create 

a stability index grid that represents the inherent hillslope mass wasting risk without the 

roads. This is compared to the stability index grid produced by GRAIP that is modified to 

account for road related risk (called the combined stability index). In this way, the effect 

of the road on terrain stability can be determined. Additionally, SINMAP creates a 

calibration grid that is used by the GRAIP toolbar to determine the combined stability 

index.  

 There are seven grids created by SINMAP (demcal, demfel, demang, demslp, 

demsca, demsi, and demsat), and four text files (demcalp, demrtp, demlsf, and demstat). 

The grid demcal is the calibration region used later by the GRAIP toolbar. The grid demsi 

is the stability index grid. 

 There are three menu headings in the SINMAP toolbar: Initialization, Grid 

Processing, and Stability Analysis. The Initialization menu sets the parameters for the rest 

of the analysis, and generates the calibration grid (demcal) and a text file (demcalp). The 

Grid Processing menu prepares the DEM for analysis according to the previously 

determined parameters. It generates a pit-filled DEM grid (demfel), a flow direction grid 

(demang), a slope grid (demslp), and a contributing area grid (demsca). The Stability 

Analysis menu analyzes the terrain for stability based on the previously determined 

parameters and generated grids. It generates the stability index grid (demsi) and the 

saturation grid (demsat), as well as a series of text files (demrtp, demlsf, and demstat). 

 SINMAP creates a folder called SINMAPData for all of its files and grids. This is 

automatically located in the same directory as the DEM you base the analysis on. This 

should be the same DEM that has been used all along for the GRAIP process, and is 

therefore the DEM that is located in the folder with all of the TauDEM files and grids. It 

might be tempting to use the resampled 5 m DEM because it has a higher resolution, but 

this will create errors or it will not work at all. You should use a 30 m DEM for this 

process. Consult the SINMAP manual for more detailed discussion (available through the 

same SINMAP website as specified in the Introduction). 

 In order to calibrate SINMAP, you will need a point shapefile of known locations 

of shallow landslides that occur in similar terrain to that in which your roads are located. 

If the roads are located in steep country underlain by basalt and at 5000 ft elevation, then 

the landslides shapefile should cover similar terrain in the same or an adjacent watershed. 

In this case, you would not want a landslide shapefile for a nearby area that is mostly soft 

sandstone and is located at only 1500 ft elevation. Many landslide GIS layers are 

available only as polygons. If this is the case, create a new point shapefile in which you 

add a point at the uppermost portion of each landslide polygon. There are many ways to 

do this, but if you are creating or moving points, it is useful to use snapping. Landslide 

GIS layers may be available at a state level, at a watershed level, etc., and may be 
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obtained from a state GIS clearinghouse, some other state land management agency, the 

local or regional Forest Service or BLM website, etc. Be sure that the landslides in your 

layer are mostly shallow (i.e. not caused by deep underlying geological phenomena). 

 Calibration consists of changing the parameters that SINMAP uses so that the 

landslides mostly fall into areas classified as unstable. If there are few landslides in the 

area of the map classified as stable, and many landslides in the area classified as unstable, 

then it is simple to infer that the other parts of the map that are classified as unstable but 

do not yet have recorded landslides are at greater risk of shallow landslides than the areas 

that are classified as stable. 

 

1. Open ArcMap or a new map file. SINAMP toolbar-> Initialization-> Select DEM 

Grid For Analysis. 

a. Navigate to the correct DEM, select it, and click Add. 

b. The selected DEM will be added to ArcMap, and the SINMAPData folder will be 

created under the same directory as the DEM. 

2. SINMAP toolbar-> Initialization-> Make Single Calibration Region Theme 
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a. Various parameters can be changed so that the stability index grid is more 

accurate for the specific area being analyzed in this step. The defaults are fine for 

now. If you calibrate to known landslides, you will come back to this step to enter 

the calibrated parameters and then re-run the rest of SINMAP. 

b. Click OK. 

c. The calibration grid is created, added to ArcMap, and saved to the SINMAPData 

folder. 

3. SINMAP toolbar-> Initialization-> Select Landslide Points Theme 

a. Do this step only if you have a shallow landslide points shapefile and intend to 

conduct a calibration; otherwise, skip to step 4. 

b. Navigate to your landslide points shapefile-> select it-> click Open. 

4. SINMAP toolbar-> Grid Processing-> Compute All Steps 

a. No further input is necessary. 

b. The above described four grids are created and added to ArcMap, and are saved to 

the SINMAPData folder. 

5. SINMAP toolbar-> Stability Analysis-> Compute All Steps 

a. No further input is necessary. 

b. The above described final two grids are created and added to ArcMap. A statistics 

window (S-A Plot) appears. The grids are saved to the SINMAPData folder. 
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i. The S-A Plot has contributing area on the Y-axis (logarithmic scale) and 

hillslope on the X-axis. Generally, the greater the slope and contributing area, 

the greater the risk of shallow landslides. 

ii. The S-A Plot can be generated easily on its own, so you can close this 

window. Go to Stability Analysis-> SA plots. 

iii. In the S-A Plot window, check both Region1: -Points and Region1: -Lines. 

iv. This plot is used for the calibration of SINMAP to known landslides. 

6. Use the S-A Plot to calibrate the SI grid. If you do not want to calibrate to landslides, 

do not do this step.  

a. The S-A Plot has two buttons in the upper left corner of the window. The Par Edit 

button opens a window, which is where you will enter new calibration parameters. 

The Statistics button opens a window that displays statistics about the distribution 

of landslides among the various stability regions and how much of the land area 

falls into the various stability regions.  

b. The main S-A Plot shows two kinds of points in its graph. The hollow circles 

are random points and give a general distribution of the slope-contributing area 

relationship of the landscape you are working with. The large blue diamonds 

are where each of the landslides from your landslide points layer fall on the 

graph.  
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c. Each of the five vertical lines on the graph represents a break between stability 

index classes. The lines labeled as SI > 1 are the stable regions, and those labeled 

as SI < 1 are the unstable regions. You may notice that your landslides are 

weighted to the unstable regions already. The goal of the calibration is to move 

the break points (the lines) so that the stable to unstable break line (SI = 1) most 

closely follows the natural break in the landslide distribution. Additionally, the SI 

= 0.0 line should be moved so that it is on the outside edge of the point 

distribution (this moves the SI = 0.5 line, as well). 

i. If there is no apparent pattern to the landslides (i.e. they are not weighted to 

one side or the other and are seemingly evenly distributed), a few things could 

be going on. 
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 Your landslide layer could cover too large of an area, and cover too much 

variation in geology, soil type, etc. 

 Your landslides may not be driven by slope or contributing area (e.g. they 

are too deeply seated, such as in bedrock along a fault plane). 

 Your landslide layer may not be accurate, due to inconsistencies in their 

mapping (multiple types of landslides mapped, points misplaced, etc.). 

d. Open the Adjust Calibration Parameter for Region 1 window by clicking on the 

Par Edit button. Each of the values in the window is editable. By changing the 

values, you change the location of the vertical lines. Generally, the parameters 

labeled as Lower Bound affect the location of the lines with higher SI values (left 

side), and the parameters labeled Upper Bound affect the lower SI values (right 

side). 
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i. Iteratively change these values until the lines fit as described above. After 

each parameter change, click OK to see your change take effect in the graph. 

ii. This process becomes easier after you have done it a few times. It is a good 

idea to play with each value to see what effect it has. 

iii. When you have found a good set of parameters that seem to match the 

landslide data, write them down. 

e. Close the S-A Plot window, open a new map file or restart ArcMap, and delete the 

SINMAPData folder that was created earlier and has all of the SINMAP data in it. 

Do not delete the DEM. You may want to move the SI grid out of the folder so 

that you can compare the uncalibrated grid to the calibrated grid. 

f. Go back to step 1 and run through SINMAP again, except when you create the 

calibration region, enter the calibrated parameter values that you determined, 

above. Complete the model run through step 5. 

i. The SI grid that is generated is now calibrated according to your parameters. 

The distribution of the stability regions has changed. 

ii. You can view the Statistics window in the S-A Plot to see exactly how your 

landslides are distributed. You should see a jump in the % of Slides row at the 

Lower Threshold column. 
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g. Make sure to keep a record of the values you used for each calibration parameter, 

as you may want to come back to rerun SINMAP later, and you will want these 

values later in the GRAIP analysis. 

 

 

Immediately after its creation, the stability index grid has nice classified, colored, 

and labeled symbology (Figure 18). This same symbology is present in the combined 

stability index grid after it is created. If either of those grids are added to ArcMap from a 

file (i.e. not at the same time that they are created), that symbology is lost. There are two 

good ways to easily recover the pre-set symbology, without setting it all by hand. They 

work for both the stability 

index grid (demsi) and the 

combined stability index grid 

(demsic), created later in the 

GRAIP toolbar as well as any 

other GIS layer that has 

symbology that you want to 

keep.  

 

 

The first method; save a layer with defined symbology as a layer file: 

 

1. After the creation of the stability index grid, go to the Table of Contents window-> 

right-click on the stability index layer name-> Save As Layer File…. Choose a name 

and location-> Save. 

a. Notice that the file extension is .lyr. 

Figure 18. Default symbology of the stability index layers. 
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2. To use the symbology of the saved layer file, right click the layer needing symbology 

in the Table of Contents window-> Properties-> Symbology tab-> click Classified in 

the right-hand section of the screen-> click Import-> click the button to the right of 

the Layer field-> navigate to and select the saved layer file-> click Add-> click OK-> 

click OK to exit the Properties window. 

a. The symbology shows up with the same colors, labels, and breaks as the saved 

layer file. 

 

 

The second method; use the already defined symbology of another stability index layer to 

define the symbology of an undefined stability index layer: 

 

1. Go to the Symbology-> Classified window of the layer needing symbology. Click 

Import-> use the drop-down to choose the layer that has the symbology you want-> 

click OK-> click OK to exit the Properties window. (See below). 

a. The symbology shows up with the same colors, labels, and breaks as the chosen 

layer. 



 

 86 

b. Note that if this method is used, and if you change the symbology of the original 

layer, then the symbology of each of the layers that are based on this layer will 

also change 
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The GRAIP Toolbar Menus 

 

 There are five main menu headings and two tools in the GRAIP toolbar. The File 

menu  (Figure 19) allows you to open the .graip file (Open), save the .graip file (Save and 

Save As…), and manage where files are saved and found (File Management). The Open 

function adds the DrainPoints, RoadLines, demnet, and DEM to the ArcMap viewer. It is 

necessary to use the Open function to do this so that the RoadLines and DrainPoints 

tables can be joined to 

their corresponding 

tables in the GRAIP 

Database 

(FileName.mdb). 

Generally, there won’t 

be any reason to use the 

other functions of this 

menu. The File 

Management function 

can be useful, but it is 

usually easier and 

simpler to establish a 

file system that is 

compatible with the 

default parameters 

(Figure 20). 

 The 

Preprocessor menu 

(Figure 21) allows you 

to run the GRAIP 

Preprocessor 

(Preprocessor Utility) 

and complete a couple of steps necessary before any numbers are generated (Create 

TauDEM Stream Network, and Resample DEM). It is better to use the separate GRAIP 

Figure 19. The File menu in the GRAIP toolbar. 

Figure 20. The File Management window from the File menu. 

Figure 21. The Preprocessor menu in the GRAIP toolbar. 
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Preprocessor program than that included in this menu. Some of the rest of the steps may 

not be necessary, depending on what you intend to get from GRAIP. 

 The last three menus, Road Surface Erosion Analysis (Figure 22), Mass Wasting 

Potential Analysis (Figure 24), and Habitat Segmentation Analysis (Figure 23) generate 

the grids and data tables. If you have not done so already, it will be necessary to run 

SINMAP before beginning the steps under Mass Wasting Potential Analysis. Each 

process from these menus should be run from top to bottom (except the Combined 

Stability Index step, and each menu run from left to right. Often, a step requires 

something generated in the previous steps. The second step in the Habitat Segmentation 

Analysis menu, Fish Habitat Segmentation, is now defunct and non-functional. 

Information previously generated in this step can be found in other, more efficient ways. 

 The two tools are the Drain Rex and Road Rex (Figure 25). These trace the road 

segments that drain to a particular drain, and the drain points that drain a particular 

road, respectively. They do not work reliably in GRAIP v. 1.0.8 or older. To use them, 

Figure 24. The Mass Wasting Potential Analysis menu from the GRAIP toolbar. 

Figure 22. The Road Surface Erosion Analysis menu from the GRAIP toolbar. 

Figure 23. The Habitat Segmentation Analysis menu from the GRAIP toolbar. 
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select the tool from the toolbar, and click on the drain (for the Drain Rex), or road (for the 

Road Rex). The associated road or drain will change color to blue and red, respectively. 

 

Figure 25. The Drain Rex and Road Rex tools from the GRAIP toolbar. 



 

 90 

Preprocessing 

 

 There are five items under the Preprocessor menu. The Preprocessor Utility is 

discussed above. Extract Stream Crossing, and Filter Stream Crossings are related to the 

old Fish Habitat Segmentation step, and are now defunct. Create TauDEM Stream 

Network generates a new stream network shapefile that replaces that generated by 

TauDEM and is split at the road-stream crossings. Resample DEM generates a new DEM 

that is interpolated to be on a five meter scale for road segment slope analysis. 

 Additionally, Hawth’s Tools is used to create a point file of the intersections of 

the roads and streams. Hawth’s Tools is picky about projections. If the Tools don’t work, 

define the projection of all input layers (described below), or use the alternative method 

presented below. 

 Keep in mind that not all stream crossings that have been observed and recorded 

in the field will show up in the stream network shapefile (Figure 26). The inverse is also 

true: Not all stream crossings that are in the stream network shapefile will necessarily be 

recorded in the 

field. The stream 

network shapefile is 

generated based on 

a set of parameters 

defined in 

TauDEM. As such, 

if the parameters 

are imperfect, as 

they always 

necessarily are, 

TauDEM will 

generate a stream 

network that is 

more or less dense 

than observed. The 

degree of error can 

be reduced with 

better stream 

definition 

parameters, but not 

eliminated, because 

there are exceptions 

to any rule or 

parameter in the 

field. Additionally, 

there can sometimes 

be confusion in the field about what, exactly, qualifies as a stream crossing, and so real 

crossings can be recorded as something else, and non-real crossings can be recorded as 

crossings. Generally, all of these errors apply to smaller or ephemeral streams that would 

be unlikely to support fish. If a recorded drain point of any kind is observed to deliver 

Figure 26. In this example from the Mt. Hood NF in Oregon, there are significantly 

more streams that were observed (red dots) than were calculated by TauDEM.  In this 

instance, this is because of bedrock controlled springs along this particular road. 
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sediment to a stream, the model will properly route the sediment downhill, no matter 

where the stream is in the stream network shapefile. For those reasons, the above errors 

rarely pose a problem during the data analysis process. 

You may want to make a copy of the stream network shapefile (demnet) before 

proceeding, so that you have an original, uncut version. Place the copy in its own 

workspace so that it does not get confused for the working copy. 

 

1. Open ArcMap and open the .graip. 

a. GRAIP toolbar-> File-> Open-> navigate to the 

location of the .graip and select it-> click OK. 

DrainPoints, RoadLines, demnet, and the DEM will 

be added to the map. 

2. Use Hawth’s Tools to create points at the road-stream 

intersections, which make up the Outlets layer used by 

the GRAIP Create TauDEM Stream Network step. 

a. Hawth’s Tools toolbar-> HawthsTools menu-> Vector Editing Tools-> Intersect 

Lines (make points). 

i. For Line/poly layer, use the drop down to select the RoadLines layer. 

ii. For Intersect line/poly layer, select the demnet layer. 

iii. For Output, click the button to the right of the field, navigate to the same 

location as the rest of the shapefiles, name the file “Outlets,” click Save, and 

then OK. 

iv. The new shapefile is added to ArcMap. It is composed of the points at which 

the roads intersect the stream network. 
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b. Make sure all of the points created are on valid road-stream intersections. If the 

road is mis-registered relative to the stream network shapefile, the road may cross 

the stream in the map when it does not cross the stream on the ground, resulting in 

too many points. If this is a problem, it should be fixed following the above 

outlined road line straightening process, including re-running the GRAIP 

Preprocessor. 

3. GRAIP toolbar-> Preprocessor-> Create TauDEM Stream Network. Click the box 

next to the field for Select Outlets Shapefile, and navigate to the location of the 

Outlets shapefile. Select it, click Add, then Compute. When asked if it is OK to 

overwrite files, click Yes (it will ask this four times). 

a. The stream network shapefile that was created by TauDEM has been deleted and 

replaced with this new stream network shapefile that is the same, except that the 

streams are split at the road-stream intersections. 
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4. GRAIP toolbar-> Preprocessor-> Resample DEM. 

a. Check to make sure that DEM (under Input) is correctly located. 

b. Check to make sure that DEM Interpolated to a Finer Scale will be saved to the 

right place. 

c. Click Compute. The re-interpolated DEM (demr) is added to ArcMap. 

 

 

A variation on the above method, for use if Hawth’s Tools does not work (this step 

replaces step 2, above): 

 

2.   Create an outlet file for the Create TauDEM Stream Network step to use by hand. 

a. Open ArcCatalog and navigate to the folder with all of your shapefiles. Create a 

new shapefile called “Outlets.” 
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i. Right-click in the shapefiles folder-> New-> Shapefile… 

ii. Name it “Outlets,” and select Point as Feature Type. 

iii. Click OK. 

b. Add the Outlets shapefile to ArcMap. Note that it does not have any points in it.  

c. Editor toolbar-> Editor-> Start Editing. Select the folder with the Outlets 

shapefile. Set the Target to 

the Outlets layer. 

d. Zoom in as close as possible on each road-stream intersection with the Zoom In 

tool from the Tools toolbar. 

i. Select the Sketch Tool (to the immediate right of the Edit Tool). Move it 

directly over the road-stream intersection, and 

click to create a point. Save the edit and zoom 

out. 

ii. Repeat for all other road-stream intersections. 

e. Editor toolbar-> Editor-> Stop Editing. The Outlets shapefile is now populated 

with all of the necessary points for the next step. 
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Road Surface Erosion Analysis 

 

 The Road Surface Erosion Analysis menu calculates how much sediment is 

predicted to come off of the roads, how much of that may reach the streams, and where 

else the sediment is ending up. The functions in this menu require an accurate road 

length, so the road lines must be free of zigzag.  

There are six tools under the Road Surface Erosion Analysis menu in the GRAIP 

toolbar, and they must be run from top to bottom. The first two steps calculate sediment 

production and accumulation, and delivery to streams for the road lines and drain points. 

These steps populate the Length (units meters), Slope (no units), SedProd1 (kg/yr), 

SedProd2 (kg/yr), UnitSed (kg/m/yr), TotSedProd (kg/yr), TotSedDel (kg/yr), and 

UnitTotSedProd (kg/m/yr) columns in the RoadLines table, and the SedProd (kg/yr), 

ELength (m), UnitSed (kg/m/yr), and SedDel (kg/yr) columns in the DrainPoints table. 

 The second two steps create three grids. The first two are weight grids that show 

sediment accumulation at drain points (demswt) and in the streams (demsac). The last 

grid is the upstream specific sediment grid (demspe), which shows sediment 

contributions from the roads directly to the stream. 

 The final two steps calculate sediment accumulation and direct accumulation for 

the stream network. Four columns are appended to the table for the stream network 

(demnet). These are SedAccum (kg/yr), SpecSed (Mg/km
2
/yr), SedDir (kg/yr), and 

SpecSedDir (Mg/km
2
/yr). For more information on the above described processes, see 

Appendix B. 

 

1. Open ArcMap and open the GRAIP file, if they are not already open from the 

previous step. 

2. GRAIP toolbar-> Road Surface Erosion Analysis-> Road Segment Sediment 

Production. 
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a. Ensure the RoadLines layer is properly located in the Road Shapefile field. 

b. Ensure that demr is properly located in the DEM Interpolated to a Finer Scale 

field. 

i. If this field is blank, demr has not been added to the map. Click the {…} 

button to the right of the field, navigate to demr, select it, and click Add. 

ii. demr is added to the map. 

c. Click Compute. 

d. Open the Attribute Table for the RoadLines layer to ensure that the Length, Slope, 

SedProd1, SedProd2, UnitSed, TotSedProd, TotSedDel, and UnitTotSedProd 

columns are populated. The final two columns (TotSedDel and UnitTotSedProd) 

may have some cells with a zero. For all steps that modify an attribute table, if all 

or part of the appropriate columns are zeros, close the attribute table, wait a few 

seconds, and reopen it. All values should be correctly populated. 

3. GRAIP toolbar-> Road Surface Erosion Analysis-> Drain Point Sediment 

Accumulation. 
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a. Ensure that the RoadLines and DrainPoints shapefiles are correctly located in the 

Road Shapefile and Drain Points Shapefile fields, respectively. 

b. Click Compute. 

c. Ensure that the SedProd, ELength, UnitSed, and SedDel columns are populated in 

the DrainPoints Attribute Table. The SedDel column may be largely zeros and 

other columns may have some zeros at orphan drain points. 

4. GRAIP toolbar-> Road Surface Erosion Analysis-> Accumulated Upstream Sediment 

Load. 

a. Ensure that the DrainPoints shapefile is correctly located in the DrainPoints 

Shapefile field, and demp is correctly located in the same folder as the TauDEM 

files in the D8(default)/Dinf Flow Direction Grid field. 
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b. Ensure that Use D8 Contributing Area Function and Stream Connected are 

selected. 

c. Check to see that the two outputs (demswt and demsac) will be saved to the 

correct folder. If you have to change the folder, do not change their names. 

d. Check Add Layers to Map if it is not already checked. 

e. Click Compute. 

f. Make sure the two grids are reasonable. 

i. Turn off the stream network and roads layers. Zoom in on the area where the 

roads are. 

ii. The demsac layer should be on top. This layer basically traces the road 

sediment down stream from the point at which it enters the stream. There 

should be a grey to white line (color depends on amount of sediment) that 

follows the stream and originates at the drain points that deliver sediment to 

the stream. Turn the layer off when finished. 

iii. Now demswt is the top-most visible layer. This layer shows the amount and 

location of sediment accumulation at each drain point. It should look like 

white dots at the drain points that do not deliver. You may have to zoom in 

pretty close to see this, especially if the RoadLines and DrainPoints layers are 

turned on. Turn this layer off when finished to keep ArcMap from slowing 

down as it draws it every time you change views. 

5. GRAIP toolbar-> Road Surface Erosion Analysis-> Accumulated Upstream Specific 

Sediment. 
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a. Ensure demsac and demad8 are correctly located in the Accumulated Upstream 

Sediment Load Grid and Upstream Contributing Area Grid fields, respectively. 

b. Ensure the Output grid (demspe, in the Specific Sediment Accumulation Grid 

field) will be saved to the correct folder, as above. 

c. Make sure the layer will be added to the map and click Compute. 

d. Ensure that the grid is reasonable. 

i. Turn off the stream network layer and zoom in on the RoadLines layer. 

ii. This grid resembles the demsac grid, above, but the stream-tracing line won’t 

continue very far and will be grey instead of white. Turn off the layer when 

done. 

6. GRAIP toolbar-> Road Surface Erosion Analysis-> Upstream Stream Sediment Input. 

a.  Ensure demfel, demsac, demad8, and demnet are properly located in their 

respective fields (Pit Filled DEM, Accumulated Upstream Sediment Load Grid, 

Upstream Contributing Area Grid, and Stream Network Shapefile, respectively). 

b. Click Compute. 

c. Ensure that the SedAccum and SpecSed columns are populated in the stream 

network layer (demnet) Attribute Table. Both columns may be mostly zeros, 

depending on how many stream network segments are affected by the roads. 

d. There is a known error in GRAIP 1.0.8 and previous versions that occurs in this 

step. The values in the Attribute Table under the SedAccum column that are added 

by this step are erroneous in that they are too high by about a factor of ten. 
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7. GRAIP toolbar-> Road Surface Erosion Analysis-> Direct Stream Sediment Input. 

a. Ensure that the Input fields are correctly populated, as above in step 6a. 

b. Click Compute. 

c. Ensure that the SedDir and SpecSedDir fields are populated in the stream network 

Attribute Table. Both columns may be mostly zeros (even more than in step 6, 

above), depending on how many stream network segments are directly affected by 

the roads. 

d. There is a known error in GRAIP 1.0.8 and previous versions that occurs in this 

step. The values in the Attribute Table under the SedDel column that are added by 

this step are erroneous in that they are too high by about a factor of ten. 
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Mass Wasting Potential Analysis 

 

 The functions in the Mass Wasting Potential Analysis menu produce data that 

indicate the likelihood of mass wasting events along and caused by a road. The default 

parameters can often be adjusted to provide more accurate results. Some of the data 

produced can be compared to the data produced by SINMAP for a road vs. no road 

comparison. 

There are eight tools under the Mass Wasting Potential Analysis menu heading. 

The first tool and the last five tools must be run in order from top to bottom, and the 

second and third tools (Select Calibration Grid and Combined Stability Index) must be 

run separately due to the way certain drain points are treated by these functions. These 

steps can be undertaken only after SINMAP has been run. The first step finds the stability 

index at each drain point, and populates the SI column in the DrainPoints table. The 

second and third tools create the combined stability index grid and four other 

intermediary grids (demsic, demrmin, demrmax, demrdmin, and demrdmax, 

respectively), and one text file (demcalp.csv) that take the road water into account. The 

SIR column is also populated in the DrainPoints table. The combined stability index grid 

(demsic) can be compared to the stability index grid (demsi, from above) to see the affect 

the road has on the terrain stability. 

The fourth and fifth steps create a slope grid (demslpd) and populate the Slope 

column of the DrainPoints table, which is the slope of the hillslope below each drain 

point. The next step addresses gully initiation risk with the erosion sensitivity index, and 

so populates the ESI column of the DrainPoints table. The seventh step creates a road 

length vs. hillslope plot called L-S Plot (note that the Y-axis is logarithmic) that can be 

used to calibrate the ESI threshold for increased gully risk (ESIcrit). The final step 

calculates the stream blocking index (SBI) for each stream crossing, and so populates the 

PipeDiaToChanWidthRatio, PipeDiaToChanWidthScore, SkewAngle, SkewAngleScore, 

and SBI columns in the DrainPoints table. 

The combined stability index grid adds water from the road at each drain point to 

the hillslope, based on the contributing length of road and a predetermined additional 

road runoff rate (effectively increasing the contributing area at the cells in which the 

drain points lie). The overall effect is to decrease slope stability at the location of each 

drain point that receives road water. There are two drain point types, diffuse drains and 

stream crossings, that do not actually affect slope stability, but they do in the model. As 

such, these drain points must be removed from consideration before running the 

Combined Stability Index step, or the combined stability index grid will overestimate 

increases in mass wasting risk. 

Run the Stability Index function, skip the next two functions, but do run D8 Slope 

with downslope averaging, Slope at Drain Point, Erosion Sensitivity Index, Length Slope 

Plot, and Stream Blocking Index as described below. If applicable, run the Habitat 

Segmentation Analysis menu step, as well. You will then complete a set of operations on 

a copy of the road and drain points shapefiles that will result in the diffuse drains and 

stream crossings being removed from consideration the Combined Stability Index 

function. Finally, you will run the Select Calibration Grid and Combined Stability Index 

functions. 
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Functions Requiring Standard Shapefiles 

 

 Theses functions should be completed in order, after running the Road Surface 

Erosion Analysis menu functions. 

 

1. If not already open, open ArcMap or a new map window and open the GRAIP file 

(the .graip). 

2. GRAIP toolbar-> Mass Wasting Potential Analysis-> Stability Index 

a. Ensure that the DrainPoints shapefile and each of the grids are correctly located, 

and click Compute. 

b. Check that the SI column has been populated in the DrainPoints Attribute Table. 

There should not be any zero values. 

3. Skip the next two functions: Select Calibration Region Grid and Combined Stability 

Index. 
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4. Mass Wasting Potential Analysis-> D8 Slope with downslope averaging 

a. The purpose of this function is to generate a grid of slopes at each cell that will be 

used to determine the slope at each drain point, which is used to help determine 

the Erosion Sensitivity Index (see below). The method used estimates the slope at 

each cell by averaging the slope from that cell to a cell that is located a specified 

trace distance downhill. 

b. Ensure that the Pit Filled DEM (demfel) and D8 Flow Direction Grid (demp) are 

correctly located. 

c. The default value for the Downgradient Trace Distance (m) field is 150. 

i. This parameter defines the trace distance that the function will use. In some 

locations, the slope of the hill can be underestimated, because the stream 

valley bottom, which has a shallower slope than the actual hillslope is 
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included in the downgradient trace distance. It is important that the grid’s 

values reflect the actual hillslope at each drain point. If there are drain points 

in the study that are within 150 m of a stream, the Downgradient Trace 

Distance (m) may be changed to a smaller number. 

ii. First, verify that there are drain points within 150 m of a stream. If there are, 

find an average point-to-stream distance in meters for only those drain points 

that are less than 150 m from the stream. 

iii. Since the DEM has a resolution of 30 m, and you need two grid cell values to 

determine slope, you need an absolute minimum of 45 m of downslope trace 

distance (the length of the diagonal across a 30 m square is about 42 m). The 

simplest way to determine what the Downgradient Trace Distance should be 

is to take the greater of either the average point-to-stream distance or 45 m. 

However, the greater the specified trace distance, the more accurate the 

average (assuming a relatively constant slope on the hillslope). A slope 

calculated using only two grid cells will probably not be very accurate, due to 

imprecision in the 30 m DEM grid values. While 45 m might be a good 

distance to use for those points which are very close to the stream, it will not 

produce accurate results for points further away. 

 It is highly recommended that you use a number higher than 90 m. This 

would include three grid cells at a diagonal.  

 If most of the drain points that are within 150 m of the stream are within 

the same grid cell as the stream, then there is no way to take an accurate 

average hillslope, anyway, so these point-to-stream distances should be 

removed from consideration.  

 If there is only a small percentage of points within 150 m of the stream, 

then you may also consider using the default 150 m. This will result in 

inaccurate slope values for those points within 150 m, but the majority of 

points will have more accurate values. 

d. Ensure that the D8 Slope with Downslope Averaging Grid will be saved to the 

correct place. Do not change the name. 
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e. Click Compute. The layer will be added to the map, but can be turned off to save 

drawing time. 

5. Mass Wasting Potential Analysis-> Slope at Drain Point 

a. Ensure that the Drain Points Shapefile (DrainPoints) and the D8 Slope with 

Downslope Averaging Grid (demslpd) are correctly located. 

b. Click Compute. 

c. Check to make sure the Slope column is populated in the DrainPoints Attribute 

Table. There should not be any zero values (unless the slope below a drain point 

is actually totally flat). 

6. Mass Wasting Potential Analysis-> Erosion Sensitivity Index 
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a. The Erosion Sensitivity Index (ESI) assigns a value to each drain point that 

corresponds to the relative risk of a gully forming below that drain point. 

b. Ensure that the Drain Points Shapefile is correctly located. 

c. The default for the Exponent Alpha field is 2. 

d. Click Compute. 

e. Check to make sure the ESI column in the DrainPoints Attribute Table is 

populated. There may be some zero values, which are orphan drain points. This 

function sometimes takes a few moments to populate the table. 

7. Mass Wasting Potential Analysis-> Length Slope Plot 

a. This generates a graph of effective length (m) vs. hillslope (degrees) of the drain 

points, including those drain points with gullies, with ESI isolines superimposed. 

Note that the Y-axis is logarithmic. 

i. Effective length (or ELength) is the length of road that drains to each drain 

point. 

ii. The ESI isolines are plotted so that a point that lies on a particular line will 

have the ESI value of that line. 

iii. The drain points that drain to gullies are represented as diamonds, those that 

drain to landslides as triangles, and the other drain points, which to not drain 

to gullies or landslides, as plus signs. 

b. This figure can be used to pick a threshold value of ESI, above which, the risk of 

gullying increases significantly. This threshold may be referred to as ESIcrit. 
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i. Disregard or turn off the landslide points, as landslide risks may be unrelated 

to gully risks, and are addressed elsewhere in the model. 

 To turn off the landslide points, double-click anywhere in the chart area-> 

Style tab-> select Landslides from the options at right-> under Point Type, 

use the drop-down menu to select Plus-> click OK. 

ii. This process only works if ELength and hillslope are the primary gully-

forming factors. If other influences are more dominant, such as groundwater 

interception, variable soils and geology, or recent fire, then it may not be 

possible to determine reasonable ESIcrit thresholds. 

iii. Generally, if there are not many gullies observed at drain points in your area, 

then gullying may not be of enough concern to complete this calibration 

process. For example, if you have a watershed with 5000 drain points, and 

only 25 of them have small gullies (0.5%), then the risks of further gully 

forming are probably not very high. However, if you have only 100 drain 

points, and only 5 gullies (5%), then sufficient risk probably exists to justify 

this calibration process. Note that, assuming your gullies fit the ELength-
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hillslope model, the more gullies you have, the easier and more accurate your 

calibration will be. 

iv. Notice that the distribution of drain points with gullies is weighted to the 

regions of the graph with higher ESI (further right and up; longer ELength and 

steeper slope). Therefore, the higher the ESI of a drain point, the higher the 

risk of gullying. 

 If this distribution trend is not present, then it is likely that the gullies 

recorded in your data have other contributors. If this is the case, you may 

have success if you can determine which points are affected by external 

factors and remove them from consideration.  

v. The process here is to find the ESI isoline that most closely bounds the lower 

end of the cluster of drain points with gullies. This process is similar to the 

process used in the calibration of SINMAP. You will move the middle ESI 

isoline (default value of 8) until you are satisfied with its location. 

 In the L-S Plot window, click Edit Parameters. From here, you can change 

the value of each ESI isoline, as well as the value of alpha (which you first 

encountered above in the Erosion Sensitivity Index function; generally, 

there is no need to change this value). 

 Change the value of the Medium ESI field to change the location of the 

middle ESI isoline. Larger values move the line up and right; smaller 

values move it down and left. Press Ok. 

 You can view information about the distribution of drain points with 

gullies among the ESI regions (i.e. the area between the ESI isolines) by 

clicking the Statistics button in the L-S Plot window. 



 

 109 

vi. The value of the middle ESI isoline when the line most closely bounds the 

cluster of drain points with gullies is the value of ESIcrit. 

c. If you have more GRAIP data for the same area, you may want to incorporate it 

into one L-S Plot that you can use to more accurately find the ESIcrit.  This 

involves exporting the Attribute Tables of each drain point type into a spreadsheet 

program, such as Microsoft Excel, and further combining and manipulating it 

there. 

d. ESIcrit can be used to determine the distribution of drain points that have a high 

risk of gullying but do not yet have a gully. 

e. Nothing is added to any table, created, or saved in this step. 

8. Mass Wasting Potential Analysis-> Stream Blocking Index 
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a. Ensure that the Drain Points Shapefile is correctly located. 

b. Click Compute. 

c. Ensure that the PipeDiaToChanWidthRatio, PipeDiaToChanWidthScore, 

SkewAngle, SkewAngleScore, and SBI columns in the DrainPoints table are 

populated at stream crossings. Most of the values will likely be zeros, because 

most drain points are not stream crossings. 

9. If you are planning to continue with the Habitat Segmentation Analysis function, do 

so now, and come back to this point when finished. Open a new map file for the 

below steps. 

 

 

The Combined Stability Index Functions 

 

 In these steps, you will modify a copy of the road lines and drain points shapefiles 

so that the diffuse drains and stream crossings are removed from consideration by the 

Combined Stability Index function, you will re-run certain GRAIP functions on those 

modified shapefiles, and you will finally run the Select Calibration Region Grid and 

Combined Stability Index functions. 

 The copies of the shapefiles are modified by the addition of a dummy drain point 

that will route all of the water from the diffuse drains and stream crossings to a part of the 

DEM that is outside the area of interest. The CTimes in the ROAD shapefile that 

correspond to diffuse drains and stream crossings will be changed to be that of the 

dummy point. Once this operation has been completed, you will use the Preprocessor to 

make another GRAIP file (extension .graip), which gets runs through the applicable 

functions in the GRAIP toolbar. Note that if there are no diffuse drains or stream 



 

 111 

crossings, you can skip to step 12, and complete steps 12 and 13 in order with the rest of 

the Mass Wasting Potential Analysis functions, above. 

 

1. Open ArcCatalog 

a. Create a new workspace at the same level as the folder in which you have your 

shapefiles. Call it SICShapefiles or something similar.  

b. Copy and paste each of the drain point and road line shapefiles into this new 

workspace (BBASE_DI, DIFF_DRA, DTCH_REL, EXCAV_ST, LEAD_OFF, 

NON_ENGI, STRM_CRO, SUMP, WATER_BA, and ROAD). Do not copy the 

other shapefiles (e.g. END_RD or GULLY). 

2. If you have not done so, open a new map file in ArcMap. Add each of the above road 

line and drain point shapefiles, as well as the DEM from the working folder (the one 

with the TauDEM grids, etc.). 

3. Open the ROAD Attribute Table. 

a. Note each of the different VEHICLE/CDATE combinations. 

i. VEHICLE “2”/CDATE “7/11/2009”; VEHICLE “2”/CDATE “7/12/2009”; and 

VEHICLE “1”/CDATE “7/11/2009” are all different combinations. 

4. Start editing, and select any one of the drain points as the Target. Find a location on 

the DEM that is well outside of the area of interest (probably an area outside of the 

watershed in the DEM buffer zone), and use the Sketch Tool to create a new point for 

each VEHICLE/CDATE combination.  

a. It is easiest to choose a drain point that has as few attributes as possible, such as 

SUMP. 

b. If two crews collected data over three days, you will create six points to account 

for each VEHICLE/CDATE combination. 

5. Open the attribute table for the drain point that has the new points. 
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a. Note that there are mostly blank entries for each of the points that you created. 

b. Fill each of the columns in with properly formatted information. 

i. It is easiest to do this by copying from other rows, and then editing if 

necessary. This ensures that all spaces and capital letters are correct. In 

general, it is best to use default information. 

ii. In each Comment field, type, “DUMMY DRAIN,” or similar. 

iii. For each new drain point, enter one of the VEHICLE/CDATE combinations 

noted above. There should be one new point for each combination. Ensure that 

this is formatted correctly. 

iv. For the CTIME, you want to make sure to use a number that is not yet used 

elsewhere in the watershed as well as make it obvious which CTIME refers to 

which VEHICLE/CDATE combination. 

 Since no data is collected in the middle of the night, it is safe to use any 

time between about 10:00 PM and 5:00 AM. You can check the range of 

CTimes in the ROAD Attribute Table if you are unsure. 

 An easy way to remember which CTIME goes with which 

VEHICLE/CDATE combination is to use the vehicle number as the hour 

(it will usually be between 01 and 04), and the day as the time (it will 

always be between 01 and 31). So, VEHICLE “2”/CDATE “7/11/2009” 

becomes “02:11:00am” in the attribute table. 

c. Save the edits frequently. 



 

 113 

6. Open the ROAD Attribute Table. For each flow path that drains to a diffuse drain or 

stream crossing, change its CTIME to that of the appropriate dummy point (the point 

with the matching VEHICLE/CDATE combination). 

a. Scroll all the way to the right, so that both CTIME columns as well as both 

FLOW_PATH columns are showing. You may have to make the COMMENT 

column smaller to see everything you need to. 

b. Right-click the column heading for FLOW_PATH1-> click Sort Ascending. Each 

of the road segments that have Diffuse in for the primary flow path are grouped. 

c. For each Diffuse flow path, enter the appropriate dummy CTIME. 

i. Using the example above, VEHICLE “2”/CDATE “7/11/2009” becomes 

“0211” in the CTIME1 column. 

d. Repeat for the FLOW_PATH2 and CTIME2 columns. 

e. From the DIFFUSE and STRM_CRO Attribute Tables, write down each 

VEHICLE/CDATE/CTIME combination. Be sure to round the CTime correctly. 

i. Also note how many features are in each shapefile (used below). 

f. In the ROAD Attribute Table, sort the CDATE column. For each of the 

VEHICLE/CDATE/CTIME combinations noted above, enter the appropriate 

dummy CTime. 

i. You may find it easier to sort the VEHICLE column or each CTIME 

separately. 

ii. Note that each VEHICLE/CDATE/CTIME combination may appear more than 

one time in the table.  
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iii. If a drain point is an orphan, its CTime will not appear in the ROAD Attribute 

Table. 

iv. Remember to look in both the CTIME1 and CTIME2 columns. 

v. Save the edits frequently. 

g. At this point, no VEHICLE/CDATE/CTIME combination from either the 

DIFFUSE or the STRM_CRO shapefile should appear in the ROAD Attribute 

Table. 

h. Stop editing and close ArcMap or open a new map file. 

7. Open the GRAIP Preprocessor. 

a. Create a new GRAIP file (extension .graip) using the shapefiles that you modified 

in the SICShapefiles workspace and the DEM from the working folder (the one 

with the TauDEM grids, etc.). 

i. Make sure to save the new GRAIP file in the SICShapefiles folder. 

8. Open each error log (FileNameDP.log and FileNameRD.log). 

a. Make sure that there are no orphan road lines. 

b. In the drain points error log (FileNameDP.log), ensure that every diffuse drain 

and stream crossing is an orphan. The easiest way to do this is to count the 

number of entries for each drain point type and compare that number to the total 

number of features in each drain point type in each shapefile, noted above. Both 

numbers should match. 

c. If there are drain points missing from the error log, find their GRAIPDID number 

on the error log, go back into ArcMap with the appropriate shapefiles (ROAD, 

DrainPoints, and whichever drain point is missing), find that GRAIPDID’s CTime 

(similar to the process used in the Editing Data Errors section), and edit the 

ROAD Attribute Table to change it to a dummy CTime. Re-run the Preprocessor 

and re-check the error logs. 

9. In a new map file in ArcMap, open the GRAIP file with the SICShapefiles. 

10. Road Surface Erosion Analysis-> Road Segment Sediment Production. 

a. Under DEM Interpolated to Finer Scale, select the resampled DEM that you used 

before (demr). 
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b. Ensure that the Road Shapefile is correctly specified as that in the SICShapefiles 

workspace. 

c. This function populates fields necessary for the Combined Stability Index function 

to run. 

11. Road Surface Erosion Analysis-> Drain Point Sediment Accumulation. 

a. Ensure that both the Road Shapefile and the Drain Points Shapefile are correctly 

specified as those in the SICShapefiles workspace. 

b. This function populates fields necessary for the Combined Stability Index function 

to run. 

12. Mass Wasting Potential Analysis-> Select Calibration Region Grid-> navigate to the 

SINMAPData folder created previously-> select the calibration grid (demcal)-> click 

Add. The calibration region grid is added to ArcMap. 

13. Mass Wasting Potential Analysis-> Combined Stability Index 

a. Ensure that the DrainPoints and RoadLines shapefiles are correctly located from 

the SICShapefiles workspace. Ensure that the fields Calibration Parameters Text 

File, Dinf Slope, Dinf Specific Catchment Area, and Calibration Grid are 

correctly populated and located (demcalp.csv, demslp, and demsca from the 

TauDEM folder, and demcal from the SINMAPData folder, respectively). 

b. The following are default parameters: 

i. Specify Road Width (m) is 5. 
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ii. Minimum Terrain Recharge (m/hr) is 0.0009. 

iii. Maximum Terrain Recharge (m/hr) is 0.00135. 

iv. Minimum Additional Road Surface Runoff (m/hr) is 0.001. 

v. Maximum Additional Road Surface Runoff (m/hr) is 0.002. 

c. You can edit additional parameters by clicking on the View/Edit Calibration 

Parameter File button. If you have calibrated SINMAP to a landslides point layer, 

you will change the parameters in this step to match those from SINMAP. To do 

this, click the View/Edit Calibration Parameter File button. 
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i. In the Parameter Values of the Calibration Grid window that pops up, enter 

the calibrated values from SINMAP for each property in the appropriate 

column. 

  Leave the columns labeled Value and Region alone. If you have more 

than one calibration region, there will be one row for each region. 

 The next two columns, Tmin and Tmax stand for the transmissivity of the 

soil, which corresponds to the T in the T/R (Lower/Upper Bound) 

parameters in SINMAP. The R stands for terrain recharge, the value of 

which can be viewed and adjusted in the main Combined Stability Index 

screen (see above) in the Minimum/Maximum Terrain Recharge (m/hr) 

fields. For each of the T columns, calculate the value to enter, based on the 

appropriate value (Minimum or Maximum) already given for R, such that, 

 

 
   

where X is the desired value for the T/R (Lower/Upper Bound) parameters 

in SINMAP. For example, if the SINMAP calibration parameter for T/R 

(Lower Bound) is 1850, and the value for Minimum Terrain Recharge 

(m/hr) is 0.0009 (default), then solve for T, 
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Enter this value in the Tmin column and then do a similar calculation to 

find Tmax (using the Maximum Terrain Recharge (m/hr), which is 

0.00135 by default). 

 Cmin and Cmax correspond to the respective Cohesion (Lower/Upper 

Bound) parameters in SINMAP. 

 PHImin and PHImax correspond to the respective Phi(degrees) 

(Lower/Upper Bound) parameters in SINMAP. 

 RhoS corresponds to the Soil Density ( kg / m^3 ) parameter in SINMAP. 

ii. Click Save. The previously defined (in SINMAP) calibration parameters will 

be used to generate the Combined Stability Index grid. 

d. Ensure that the Combined Stability Index Grid will be saved to the correct place. 

Do not change its name. 

e. Check Add SI combined grid to map and click Compute. 

f. Five grids and one text file (calibration parameters; demcalp.csv) are created: 

i. The combined stability index grid (demsic) is added to ArcMap and saved 

wherever you specified. 

ii. The minimum and maximum depth of terrain runoff grids (demrmin and 

demrmax) are not added to ArcMap and are saved to the same place as the 

TauDEM files. These files are intermediary (i.e. they are used by the 

Combined Stability Index function and nothing else) 

iii. The specific discharge due to minimum and maximum runoff grids 

(demrdmin and demrdmax) are not added to ArcMap. These files are 

intermediary.  
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Habitat Segmentation Analysis 

 

The function in the Habitat Segmentation Analysis menu produces data that 

identifies the stream crossings which are blocked to all fish passage, and those which are 

blocked to some species or life stages of fish. This function assigns a value, 0-2, to each 

crossing, where 0 is a blocked passage to all species, 1 is blocked to some species, and 2 

is clear to all species. The Barrier column is populated in the DrainPoints Attribute 

Table. This step is usually not necessary, especially if you are not conducting a 

watershed-wide study, or if another more complete approach is being used. In order to 

complete this step, your field data must be collected using a data dictionary that has 

information on the pool depth and outlet drop at stream crossings (e.g. INVENT 4_2 or 

INVENT 5_0_W). Upon completion of this step, the GRAIP toolbar analysis is complete. 

 There is a second tool under the Habitat Segmentation menu, called Fish Habitat 

Segmentation, which is now defunct, and no longer works. This step assigned the above 

values to the stream network shapefile segments in the stream network shapefile table, 

appending the HabPatchID column to the stream network layer Attribute Table. This can 

be achieved more easily using manual methods, because this step required significant 

extra work earlier in the analysis process.  

 

1. If ArcMap is not open, open it and open the appropriate .graip. 

2. GRAIP toolbar-> Habitat Segmentation Analysis-> Fish Passage Barrier 

a. Ensure that the DrainPoints shapefile is correctly located in the appropriate Inputs 

box. 

b. You can change the parameters that define a blocked passage. 
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i. The following are default parameters: 

 Crossing Slope Sp (%) is 2. 

 Pipe/Channel Width ratio w*p is 0.75. 

 Outlet Drop ODp (ft) is 0.8 

 Outlet Drop to Pool Depth ratio is 1.125. 

c. Click Compute. 

d. Check to make sure that the Barrier column is populated with 0-2 at the stream 

crossings in the DrainPoints Attribute Table. 
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Appendix A: An Example File Management System 

 

 As described in the Introduction, it is important to have a good file management 

system in place in order to keep track of your data. Keep in mind that there are basically 

four potential locations for your files: the original DEM folder, the shapefiles folder, the 

folder with TauDEM and SINMAP files, and a folder with shapefiles that are modified 

for use in the Combined Stability Index. You may want more or less or different folders, 

such as if you desired to save all of the files that are generated by the GRAIP 

Preprocessor in a separate place from the shapefiles. Other files systems may work just as 

well or better than this one. 

 

 

  

All workspaces under C:\WorkSpace\GRAIPWorkspace… 

…\SiteWorkspace 
Holds all data for a site or area, 

usually within a watershed. 

 \DEM 
30 m DEMs, original download 

through version used in GRAIP. 

 \ComparisonsAndData 

Excel files, exported tables, saved 

layer files, etc. for use in the data 

analysis. 

 \SpecificSiteSpace 

E.g. pre-treatment or post-treatment. 

Contains all data for that specific 

site. You would not need this 

subfolder if you were not comparing 

different data sets from the same. 

  \Shapefiles  All .shapefiles and the GRAIP file. 

  \SICShapefiles 

Shapefiles with the diffuse and 

stream crossing CTimes replaced by 

a dummy CTime for use in 

determining the Combined Stability 

Index. 

  \GridsWorkspace 
All grids created by TauDEM, 

SINMAP, and GRAIP. 

   \SINMAPData Created by SINMAP for its grids. 

   \dem 
Copy of the DEM for data 

processing on that specific site. 
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Appendix B: More Details About The GRAIP Preprocessor and 

Toolbar Functions 

 

 The nuts and bolts of each function used in GRAIP have been partially omitted 

from the Section III instructions for brevity. This Appendix has more details about what 

each of the GRAIP toolbar functions do, and the equations they use. It is organized by 

GRAIP toolbar menu and function. 

 

 

GRAIP Preprocessor 

 

 The GRAIP Preprocessor is an application that validates and imports GRAIP road 

inventory shapefile attributes into a relational database structure created in the MS 

Access file format. The purpose of the GRAIP Database is to enforce referential integrity 

and ensure consistency between related attributes. The Preprocessor helps to correct 

and/or screen out invalid, corrupt, or missing data so the user has a better dataset with 

which to perform the forest road impact analysis. It also consolidates multiple drain point 

and road line shapefiles, creating a single shapefile for each. 

 

 

Preprocessor Menu and Associated Functions 

 

 Hawth’s Tools’ Intersect Lines(Make Points) function 

 This function creates a shapefile called Outlets containing points that are the 

intersection of the roads from the RoadLines shapefile with the stream network 

shapefile generated by TauDEM. 

 It is used by the Create TauDEM Stream Network function to divide the stream 

network at the road intersections so that road-derived sediment is not routed 

upstream. 

 

 Create TauDEM Stream Network function 

 This function runs the TauDEM Stream Network utility to create a new stream 

network shapefile using the Outlets shapefile which contains the road-stream 

intersection points created above. This revised stream network shapefile is similar 

to the previous version except that the stream segments are split at stream 

crossings so that road-derived sediment is not routed upstream later in the 

process. 

 

 Resample DEM function 

 This function re-samples the DEM to a finer scale using the cubic convolution 

method from the ArcGIS Toolbox. It is best to resample the DEM to 5 m. 
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 It is used to determine the slope of each road segment in the Road Segment 

Sediment Production function. 

 

 Extract Stream Crossings function 

 This function was part of the process for the defunct Fish Habitat Segmentation 

function. 

 

 Filter Stream Crossings function 

 This function was part of the process for the defunct Fish Habitat Segmentation 

function. 

 

 

Road Surface Erosion Analysis Menu Functions 

 

 Road Segment Sediment Production function 

 The Road Segment Sediment Production function calculates sediment production 

values for each road segment according to, 

   
     

 
 

 where E is the erosion from each forest road segment in kg/yr, i indicates the side 

of the road, a is the annual base erosion rate (with 79 kg/yr being the default, 

although a different value could be defined for each road segment shapefile when 

it is imported with the GRAIP Preprocessor), L is the road segment length, S is 

the slope, r is the road surface multiplier which varies depending on the type of 

road surface, and v is the flow path vegetation multiplier which varies depending 

on the density of the flow path vegetation.  LS is also equal to the difference in 

maximum and minimum elevations in the road segment. Values of these 

coefficients can be found in the GRAIP tutorial. 

 When the goal of a GRAIP analysis is to predict the sediment production and 

delivery in absolute terms, it is important to select an appropriate value for a. This 

can be accomplished by installing sediment plots on the roads in question, or by 

modeling the road segments using their soil texture, constuction, and climate data 

in a program such as WEPP:Road. 

 The three parameters, a, r and v are stored in the following field/tables in the 

project database which is the .mdb created by the GRAIP Preprocessor. These 

parameters can be edited prior to executing this step by double clicking on the 

.mdb file in the file explorer. Then double click on the table for the desired 

parameter and edit the field listed for that parameter.  Changes are automatically 

saved when you exit each record. 

1) a (annual based erosion rate) is stored in the BaseRate field in the 

RoadNetworkDefinitions table 

2) r (road surface multiplier) is stored in the Multiplier field in the 

SurfaceTypeDefinitions table 
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3) v (flow path vegetation multiplier) is stored in the Multiplier field in the 

FlowPathVegDefinitions table  

 The Road Sediment Production function populates the following fields in the 

RoadLines table in the GRAIP database (the.mdb). 

1) Slope: Road slope (no unit). 

2) Length: Road length (meters) 

3) SedProd1: Sediment production for one side of the road (kg/yr) 

4) SedProd2: Sediment production for the other side of the road (kg/yr) 

5) UnitSed: Unit sediment production from the road segment (kg/m/yr) 

6) TotSedProd: SedProd1+SedProd2 (kg/yr) 

7) TotSedDel: Sediment delivered to streams (calculated using stream connection 

information for each road) (kg/yr) 

8) UnitTotSedDel: TotSedDel/Length (kg/m/yr) 

 

 Drain Point Sediment Accumulation function 

 This function calculates sediment accumulation values for each drain point. As 

part of this, the following drain point fields are populated: 

1) SedProd: Total accumulated sediment load at each drain point due to road 

surface erosion (kg/yr) 

2) ELength: Effective cumulative length of road draining to each drain point 

(meters).  

3) UnitSed: SedProd/Elength (kg/m/yr) 

4) SedDel: Sediment delivery depending on stream connection (kg/yr) 

 This function adds up the total road sediment production from all contributing 

road segments at each drain point, and then determines where the sediment goes. 

1) If the value in the StreamConnectID column of the DrainPoints Attribute 

Table is 1, the drain point is not stream connected, so the sediment is not 

delivered to the stream. 

2) If the value in the StreamConnectID column is 2, the drain point is stream 

connected, so the sediment goes into the stream. 

 ELength is also used in the Combined Stability Index function to determine the 

amount of water present at each drain point. 

 

 Accumulated Upstream Sediment Load function 

 This function creates the following output grids: 

1) Weight grid with drain point accumulated sediment load (with a demsac name 

format). This grid shows the location and quantity of total sediment in the 

stream network, such that the value of each cell is the total of all road 

sediment that has been input above that cell. 

2) Weighted Sediment Production grid (with a demswt name format). 

 The user can select between D8 and Dinf Contributing area functions. 

 These grids are used to determine the quantity of sediment in each stream 

segment in the Upstream and Downstream Sediment Input Functions. 
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 Accumulated Upstream Specific Sediment function 

 This function creates the upstream specific sediment accumulation grid (with a 

demspe name format). 

 This grid is used to determine the quantity of sediment in each stream segment in 

the Upstream and Downstream Sediment Input Functions. 

 

 Upstream Sediment Input function 

 This function calculates sediment accumulation for the downstream end of each 

stream segment. The following fields are appended to the stream network 

shapefile (that has a demnet.shp name format): 

1) SedAccum: Accumulated Sediment Inputs for each stream segment (kg/yr). As 

of GRAIP version 1.0.8 and previous versions, there is an error in this step 

that results in the numbers reported in this column being about ten times 

higher than they should be. 

2) SpecSed: Accumulated Specific Sediment Load per unit area for each stream 

segment (Mg/km2/yr). 

 

 Direct Stream Sediment Input function  

 This function calculates the sediment load for the area draining directly to a 

stream segment. These fields are appended to the stream network shapefile (that 

has a demnet.shp name format). 

1) SedDir: Direct Sediment Inputs for each stream segment (kg/yr). As of 

GRAIP version 1.0.8 and previous versions, there is an error in this step that 

results in the numbers reported in this column being about ten times higher 

than they should be. 

2) SpecSedDir: Direct Specific Sediment Load per unit area for each stream 

segment (Mg/km2/yr). 

 

 

Mass Wasting Potential Analysis Menu and Associated Functions 

 

 SINMAP functions 

 SINMAP 2.0 is used to create a Stability Index (SI) grid and a calibration region 

grid from the DEM. Calibration regions are areas within which single lower 

bound and upper bound calibration parameters values can represent T/R 

(Transmissivity and Recharge Rate), dimensionless cohesion, friction angle (ø) 

and soil density (ρ). In a large watershed GRAIP study, substantial geologic and 

climatic variations may require multiple calibration regions. More information is 

available on the SINMAP website. 

 

 Stability Index function 

 This function looks up the Stability Index grid values at each drain point and 

stores them in the SI field in the DrainPoints table. 
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Select Calibration Region Grid function 

 This function opens the calibration grid created in SINMAP and is used for the 

Combined Stability Index function. 

 Note that you will still have to change the calibration parameters separately in the 

Combined Stability Index function. 

 

 Combined Stability Index function 

 This function creates a Combined Stability Index Grid (with a demsic file format) 

and stores the value from that grid at each drain point in the SIR field of the drain 

pint table in the GRAIP database. 

 The output and intermediate files created are below. The intermediate outputs (1) 

and (2) are not added to ArcMap. The output file (3) is added if the “Add SI 

combined grid to the Map” checkbox is checked, which is the default. There is an 

additional file created that stores the calibration parameters (demcalp.csv) 

1) Minimum and maximum depth of terrain runoff generated (with demrmin and 

demrmax file formats). 

2) Specific discharge due to road drainage for minimum runoff and maximum 

runoff (with demrdmin and demrdmax file formats). 

3) Combined Stability Index grid (with a demsic file format). 

 In this function, stability index (SI) due to terrain contributing area can be 

calculated by setting the road surface runoff to be 0, and SI due to road runoff 

only can be computed setting terrain recharge to be 0. The SI values from the grid 

are used to identify SI values to store in the SIR field in for each drain point in the 

GRAIP database. 

 

 D8 Slope Grid with Downslope Averaging function 

 This function uses the D8 flow directions approach to trace downslope and find 

the average slope for each grid cell over the specified averaging distance. The 

output from this function is the slope grid with downslope averaging (called 

demslpd). 

 You need to use at minimum  two cells to get a slope, so the minimum distance 

you can use is 45 m, because the diagonal distance across a 30 m square is about 

42 m. Longer distances (at least 90 m, or three cells at a diagonal) are 

recommended, as the road itself will often appear to influence the hillslope slope 

at the drain point. 

 This grid is used to determine the slope at each drain point, which is used to 

determine each drain point’s ESI. 

 

 Slope at Drain Point function 

 This function extracts the average slope below each drain point from the D8 slope 

grid (created above) and stores it in the Slope field in the DrainPoints table of the 

GRAIP database. 

 This data is used to determine the ESI of each drain point. 

 

 Erosion Sensitivity Index function 
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 This function populates the ESI field in the DrainPoint table. ESI is equal to LS
α
, 

where S is the hillslope and L is the effective length (ELength) of the road 

draining to each drain point, and α operates on slope and has been shown to have 

a value of about 2 (Istanbulluoglu et al. 2003). 

 

 Length Slope Plot function 

 This function shows the ELength-Slope plot with ELength on the logarithmic Y-

axis and Slope on the X-axis. 

 This plot can be used to calibrate the critical ESI (ESIcrit), which is the ESI, above 

which, the risk of gullies significantly increases. 

 

 Stream Blocking Index function 

 This function was developed by Flanagan et al. (1998). 

 This function populates these fields in the DrainPoints Attribute Table in the 

GRAIP database for stream crossing points with a culvert only: 

1) PipeDiaToChanWidthRatio: Ratio of the width of the culvert to the width of 

the channel. For example, a culvert that is 48 inches with a channel that is 5 

feet (60 inches) will have a ratio of 0.8. 

2) PipeDiaToChannelWidthScore: The pipe to channel ratio is given a score, 

based on the range in which the ratio falls: 

Condition Pipe to Channel Ratio Range Score 

Big pipe, small stream ≥ 1 1 

 0.5 - 1 2 

Small pipe, big stream < 0.5 3 

 

3) Skew Angle: The angle of the channel to the pipe, as determined in the field. 

4) SkewAngleScore: The skew angle is given a score, based on the range in 

which the angle falls: 

Channel angle Skew angle score 

> 45
o
 1 

< 45
o 

0 

 

5) SBI: Stream Blocking Index indicating plugging susceptibility based on the 

ratio of pipe diameters to channel width ratio class and skew angle score 

according to, 

                                           

Note that the range of the SBI is from 1 to 4, where 1 indicates low risk of 

blockage, and 4 indicates a high risk of blockage. 

 

 

 



 

 128 

Habitat Segmentation Analysis Menu Functions 

 

 Fish Passage Barrier function 

 This function was developed from the work of Clarkin et al. (2003). 

 This function identifies the fish passage barriers and assigns an identifier 

representing the status of the stream crossing: 0-Blocked Passage, 1- Possible or 

Unknown Passage and 2- Clear Passage.  This identifier is used to populate the 

Barrier field in the DrainPoints table in the GRAIP database.  Possible/Unknown 

Passage identifies the stream crossings that may be passable to some species, but 

not to others. 

 

 Fish Habitat Segmentation function 

 This function is now defunct, because there are less time consuming and more 

reliable manual methods to glean its information. 

 This function assigned an identifier to each stream segment indicating the habitat 

cluster to which it belongs. The habitat cluster identifier was appended to the 

TauDEM stream network shapefile Attribute Table. 
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Appendix C: Terminology 

 

Two kinds of terminology are presented here. First, a section of general GIS terms are 

defined. Next, a section of specific GRAIP terms, such as drain point types, are defined. 

 

 

GIS Terms 

 

More terms and definitions can be found in the ArcGIS Desktop Help. The terms here are 

used in this document. 

 

Attribute table… A database or table file that relates geographic features to 

information about them, usually arranged so that the individual 

features make up the rows, and information about them makes up the 

columns. In this document, when Attribute Table is capitalized, it 

refers to the attribute table for a specific layer you can view in 

ArcMap by right-clicking the layer name and selecting Open 

Attribute Table. 

Database………. A structured data set or sets, stored and managed together, and 

usually related to software that can query and modify the data. 

DEM………….... Digital Elevation Model. A DEM is a grid with cells that each 

represent continuous elevation, and are reference to a datum. The 

size of the grid cell determines the resolution of the DEM. 5x5 m, 

10x10 m, and 30x30 m are common grid cell sizes. A “five meter 

DEM” refers to a DEM with 5x5 m grid cells. 

Extent………….. The extent of a piece of data is the smallest rectangle that the data 

can fit in, defined by its minimum and maximum x- and y-values. 

The extent of a window in ArcMap is the maximum and minimum 

x- and y-values of the view contained by the window. 

Grid……………. ESRI Grid; an ESRI data format that stores raster data. 

HUC…………… Hydrologic Unit Code. The system used in the United States to 

divide the land area based on drainage into up to six levels, from 

large area (e.g. Missouri River) down to small watersheds. For 

GRAIP purposes, this refers to a shapefile containing polygons that 

conform to usually sixth level (6
th

 code) watershed boundaries. Each 

polygon covers one watershed, and each set of HUCs contains many 

polygons, generally for an entire state. 
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Isoline………….. A line that represents a constant value on a map or graph, such as 

elevation (contour line) or pressure (isobar). 

Map file……… AKA map document. The type of file in which you do your work in 

ArcMap. If you save your work in ArcMap, it is saved as a map file, 

with the extension .mxd. Layer symbology can be preserved in this 

way. 

Raster………….. Defines space as a series of equally sized square cells arranged in 

rows and columns. Each cell stores a geographic attribute about its 

place, such as elevation or slope, and is referenced by its (x,y) 

coordinate system. 

Shapefile………. Stores the location, shape, and attributes of vector data, such as 

roads, cities, lakes, and, in the case of GRAIP, drain points, etc. 

Toolbar………... In ArcMap, a toolbar is a set of related tools grouped together with 

menus or buttons that allow the user to execute functions and other 

software commands. 

 

 

GRAIP Terms 

 

Adapted from Black, et al. (2009), Fly, et al (2010), and Moll (1997). 

 

Broad based 

dip……………… 

Constructed: Grade reversal designed into the road for the purpose 

of draining water from the road surface or ditch (also called dip, sag, 

rolling grade, rolling dip, roll and go, drainage dip, grade dip). 

Natural: A broad based dip point is collected at the low point where 

two hillslopes meet, generally in a natural swale or valley. This is a 

natural low point in the road that would cause water on the surface 

of the road to drain out of the road prism.  

Cross drain……. This is not a feature collected specifically in GRAIP, and it can refer 

to a number of other drainage features. It is characterized by any 

structure that is designed to capture and remove water from the road 

surface or ditch. Ditch relief culverts, waterbars, and broad based 

dips can all be called cross drains. 

Diffuse drain…... This is a point that is characterized by a road segment that does not 

exhibit concentrated flow off the road. Outsloped roads or crowned 

roads often drain half or all of the surface water diffusely off the 

fillslope. Although collected as a drain point, this feature is 

representative of an area or a road segment rather than a 

concentrated point where water is discharged from the road prism. A 
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drop of water that lands on a diffuse road segment will not flow 

down the road or into the ditch, but more or less perpendicular to the 

centerline off the road surface and out of the road prism. Also called 

sheet drainage or inter-rill flow. 

Ditch relief 

culvert………..... 

This drain point is characterized by a conduit under the road surface, 

generally made of metal, cement, or wood, for the purpose of 

removing ditch water from the road prism. This feature drains water 

from the ditch or inboard side of the road, and not from a continuous 

stream channel. 

Flow path……… This is the course flowing water takes, or would take if present, 

within the road prism. It begins where water is concentrated and 

flows along the road or it enters the road prism, and ends where 

water leaves the road prism. This can be either on the road surface, 

or in the ditch. Flow path types in GRAIP are ditch, diffuse, and 

concentrated. 

Lead off ditch…. This drain point is characterized by a ditch that moves flow from the 

roadside ditch and leads it onto the hillslope. Occurs most often on 

sharp curves where the cutslope switches from one side of the road 

to the other. Also known as a daylight ditch, mitre drain, or a ditch 

out (though this term can also describe other types of drainage 

features). 

Non-engineered 

drainage………... 

This drain point describes any drainage feature where water leaves 

the road surface in an unplanned manner. This can occur where a 

ditch is dammed by debris, and the water from the ditch flows 

across the road, where a gully crosses the road, where a wheel rut 

flow path is diverted off the road due to a slight change in road 

grade, or where a berm is broken and water flows through. This is 

different from a diffuse drain point, which describes a long section 

of road that sheds water without the water concentrating, whereas 

this point describes a single point where a concentrated flow path 

leaves the road. 

Orphan drain 

point……………. 

This is any drain point that does not drain any water from the road at 

the time of data collection. Examples include a buried ditch relief 

culvert, or a water bar that has been installed on a road that drains 

diffusely. 

Stream crossing.. This drain point is characterized by a stream channel that intersects 

the road. This feature may drain water from the ditch or road 

surface, but its primary purpose is to route stream water under or 

over the road via a culvert, bridge, or ford. A stream for the 

purposes of GRAIP has an armored channel at least one foot wide 

with defined bed and banks that is continuous above and below the 
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road and shows evidence of flow for some part of most years. 

Sump…………… Intentional: A closed depression where water is intentionally sent to 

infiltrate. Unintentional: Any place where road water enters and 

infiltrates, such as a cattle guard with no outlet, or a low point on a 

flat road. 

Waterbar………. This drain point is characterized by any linear feature that is 

perpendicular to the road that drains water from the road surface 

and/or ditch out of the road prism or into the ditch. Waterbars may 

be constructed by dipping the grader blade for a short segment, or 

adding a partly buried log or rubber belt across the road. Some road 

closure features may also act as a waterbar, such as a tank trap (also 

known as a closure berm or Kelly hump). Cattle guards that have an 

outlet that allows water to flow out are also considered to be water 

bars. These features may also be known as scratch ditches if they 

drain water into the ditch. 
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Appendix D: Attribute Table Field Name Explanations 

 

This appendix presents the field names (column headings) for each of the three 

main GRAIP-created or modified shapefile attribute tables (DrainPoints, RoadLines, and 

the stream network shapefile demnet) with an explanation of what is in those columns. 

Each field name appears in top-down order as it appears in the attribute table left-to-right. 

There are a few notable inconsistencies between these tables and those that you 

may see in the GIS. First, the capitalization may be different; the field names may appear 

as all caps in the attribute table. The field names may appear to be truncated in the 

attribute table (e.g. FlowPathCond2ID may appear as FlowPath_2). The DrainPoints and 

RoadLines Attribute Tables are joined to other tables from the GRAIP database, which 

results in RoadLines and DrainPoints appearing before the field name in each column 

(e.g. RoadLines.FlowPathCond1ID). Finally, many of the fields are numerical 

representations (called IDs) of data from each shapefile (e.g. Grass and Herbs from the 

ROAD shapefile Attribute Table has the ID 2 in the RoadLines Attribute Table). As such, 

if the value of a particular ID in one of these columns is zero, then there is no data for 

that particular field in that feature (e.g. there is no option in the DIFFUSE drain point for 

the OrphanID  field, so its value will always be 0). 

 

 

RoadLines Attribute Table 

Field Name Description 

FID Feature ID number 

Shape Polyline; type of shapefile 

GRAIPRID GRAIP ID number 

GRAIPRID GRAIP ID number 

CDate Collection Date 

CTime1 Collection Time - flowpath 1 

CTime2 Collection Time - flowpath 2 

VehicleID Crew Identifier number 

RoadNetworkID Road Network Identifier 

RoadTypeID Road Type 

  1 Passenger car road 

  2 High clearance Road 

  3 Not trafficable 

  4 Decommissioned 

OrigDrainD1 Drain point ID - flowpath 1 

OrigDrainD2 Drain point ID - flowpath 2 

GRAIPDID1 Drain point FID - flowpath 1 

GRAIPDID2 Drain point FID - flowpath 2 
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SurfaceTypeID Surface Type ID 

  1 Crushed Rock 

  2 Native 

  3 Paved 

SurfaceConditionID Surface Condition ID 

  1 Good 

  2 Rilled/eroded 

  3 Washboard 

  4 Rutted 

  5 Rocky 

  6 Ripped 

  7 Decom potholed 

  8 Recontoured 

  9 Tilled 

SurfaceCov Surface Cover ID 

  1 None 

  2 Grass and herbs 

  3 Live woody veg 

  4 Straw 

  5 Organic debris 

RoadEdge1ID Road Edge 1 ID (ft) 

  1 Fill 

  2 0' no ditch 

  3 0 - 6' 

  4 >6' 

RoadEdge2ID Road Edge 2 ID (ft) 

  1 Fill 

  2 0' no ditch 

  3 0 - 6' 

  4 >6' 

EdgeConditionID Edge 1 condition 

  1 No Problem 

  2 Badly rilled 

  3 Badly ravelling 

  4 Badly slumping 

  5 Bedrock 

  6 Seep spring 



 

 135 

FlowPath1ID Flowpath 1 Type ID 

  1 Ditch 

  2 Diffuse 

  3 Concentrated 

FlowPath2ID Flowpath 2 Type ID 

  1 Ditch 

  2 Diffuse 

  3 Concentrated 

FlowPathVeg1ID Flowpath 1 Veg cover 

  1 <25% 

  2 >25% 

FlowPathVeg2ID Flowpath 2 Veg cover 

  1 <25% 

  2 >25% 

FlowPathCond1ID Flowpath 1 Condition 

  1 No problem 

  2 Gullied 

  3 Buried ditch 

  4 Rocked 

  5 Eroded 

  6 Stream course 

FlowPathCond2ID Flowpath 2 Condition 

  1 No problem 

  2 Gullied 

  3 Buried ditch 

  4 Rocked 

  5 Eroded 

  6 Stream course 

FillChannelID Distance from base of fill to stream channel (ft) 

  1 0 

  2 1-20 

  3 21-50 

  4 Above 50 

Comments Comments from the field crew 

StreamConnect1ID Stream connection - flowpath 1 

  1 No 

  2 Yes 
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StreamConnect2ID Stream connection - flowpath 2 

  1 No 

  2 Yes 

Orphan1ID Drain point orphan - flowpath 1 

Does not function 1 No 

  2 Yes 

Orphan2ID Drain point orphan - flowpath 2 

Does not function 1 No 

  2 Yes 

Length Length (m) 

Slope Slope (L/L) 

SedProd1 Sediment production - flowpath 1 (kg/yr) 

SedProd2 Sediment production - flowpath 2 (kg/yr) 

UnitSed 
Sediment production - both flowpaths 

(kg/m/yr) 

TotSedProd Sediment production - both flowpaths (kg/yr) 

TotSedDel Sediment delivery - both flowpaths (kg/yr) 

UnitTotSedDel Sediment delivery - both flowpaths (kg/m/yr) 

RoadNumber Road number entered in field survey 

 

 

DrainPoints Attribute Table 

Field Name Description 

FID Feature ID number 

Shape Point; type of shapefile 

GRAIPDID GRAIP ID number 

GRAIPDID GRAIP ID number 

DrainTypeID Drain Point Type ID 

  1 Broad Based Dip 

  2 Diffuse Drain 

  3 Ditch Relief 

  4 Lead Off Ditch 

  5 Non-Engineered 

  6 Stream Crossing 

  7 Sump 

  8 Water Bar 

  9 Excavated Stream Crossing 
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Cdate Collection Date 

Ctime Collection Time 

VehicleID Crew Identifier Number 

DrainID Drain point ID 

StreamConnectID Stream Connection 

  1 No 

  2 Yes 

OrphanID Drainpoint orphan 

  0 Not applicable for drain type 

  1 No 

  2 Yes 

Comments Comments from field crew 

SedProd Produced sediment routed to drain point (kg/yr) 

Elength Effective length of flowpath to drain point (m) 

UnitSed Produced sediment per meter of road draining to drain point (kg/m/yr) 

SedDel Sediment delivered to the stream (kg/yr) 

SI Stability Index 

SIR Combined Stability Index 

Slope D8 Slope  (L/L) 

ESI Erosion Sensitivity Index 

PipeDiaToChanWidthRatio Ratio of pipe diameter to channel width 

PipeDiaToChanWidthScore Score for PipeDiaToChanWidthRatio 

SkewAngle Angle between pipe and channel 

SkewAngleScore Score for SkewAngle 

SBI Stream Blocking Index 

Barrier Fish passage barrier score 

  0 Blocked to all species 

  1 Blocked to some species 

  2 Open to all species 

 

 

Stream Network Shapefile Attribute Table 

Field Name Description 

FID Feature ID number 

Shape Polyline; type of shapefile 

LINKNO Link number 

DSLINKNO Downstream link number 
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USLINKNO1 Upstream link number 1 

USLINKNO2 Upstream link number 2 

DSNODEID Downstream node ID 

Order Strahler stream order 

Length Length of segment (m) 

Magnitude Shreve magnitude 

DS_Cont_Ar Contributing area at downstream end m
2
 

Drop Vertical drop (m) 

Slope Slope (L/L) 

Straight_L Straight line distance from start to end of segment (m) 

US_Cont_Ar Contributing area at upstream end m
2
 

WSNO Watershed number 

DOUT_END Distance to outlet from downstream end of segment (m) 

DOUT_START Distance to outlet from upstream end of segment (m) 

DOUT_MID Distance to outlet from at midpoint of segment (m) 

SedAccum Sediment accumulation (kg/yr) 

SpecSed Sediment accumulation (Mg/km
2
/yr) 

SedDir Sediment delivered to section (kg/yr) 

SpecSedDir Sediment delivered to section per catchment area (Mg/km
2
/yr) 
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Appendix E: Examples Of The GRAIP-Created Grids 

 

 GRAIP creates 10 grids during it’s processes. These grids are demr, demswt, 

demsac, demspe, demrmin, demrmax, demrdmin, demrdmax, demsic, and demslpd. 

Some are used by GRAIP steps further along, and some are the end product to be used for 

the analysis. The Appendix contains an example of each GRAIP-created grid in order to 

show what they all generally look like. Examples are from the Oak Creek watershed in 

western Oregon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The base DEM, clipped to 

the watershed boundaries 

with a buffer. This is a 30 

m DEM. 

The resampled (to 5 m) DEM 

(demr) from the Resample 

DEM function in the 

Preprocessor menu. 
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The Accumulated Upstream Sediment Load Grid (demsac, on left) and the Sediment Production Weight Grid 

(demswt, on right) from the Accumulated Upstream Sediment Load function from the Road Surface Erosion 

Analysis menu. 

The Specific Sediment 

Accumulation Grid 

(demspe) from the 

Specific Sediment 

Accumulation function 

under the Road Surface 

Erosion Analysis menu. 
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 Clockwise from top left, the minimum and maximum depth of terrain runoff grids (demrmin and demrmax) 

and the specific discharge due to road drainage for minimum and maximum runoff (demrdmax and 

demrdmin). These grids are generated by and used only by the Combined Stability Index function under the 

Mass Wasting Potential Analysis menu. They are not automatically added to ArcMap, and you won’t need to 

add them. 
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The Combined Stability 

Index Grid (demsic) from 

the Combined Stability 

Index function under the 

Mass Wasting Potential 

Analysis menu. 

 

The D8 Slope with 

Downslope Averaging 

Grid (demslpd) under the 

Mass Wasting Potential 

and Analysis menu. 
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Release Notes 

Version 
Number 

Release Date Notes 

1.0.0 5/24/07  

1.0.1 6/4/07  

1.0.2 7/6/07  

1.0.3 7/10/07  

1.0.4 8/14/07 
 Link between Roadlines and Drainpoints created from 

CDate, CTime and Vehicle fields 

1.0.5 9/14/07 

 If near match is found for Add Value, reassign now 
initially selected 

 Added alpha and beta parameters to the Filter Stream 
Crossing function. 

 Added Slope to the Roadlines table 

 Added alpha parameter to the LS Plot function. 

 Clarified the meaning of Possible Passage. 

1.0.6 2/29/08 

 Added ability to have multiple input shapefiles of the 
same type 

 Expanded the length of several text fields in the database. 

 Fixed the preprocessor so that the file info is saved when 
an additional file is added to an existing project. 

 Delete Drainpoints and Roadlines index files when the 
shapefiles are deleted in the preprocessor so that expired 
index fields don’t cause drain points and road line 
segments to disappear in ArcGIS. 

1.0.7 3/9/09 

 Fixed Elength calculation. 

 Fixed RemoveGrid function to only scan for GRID files 
rather than all raster dataset files. This prevents errors 
when there is another file with a raster dataset extension in 
the workspace. 

1.0.8 3/20/10 

 Fixed bug in the writing of parameters file for combined 
stability index function. The program should no longer 
overwrite parameters with the default parameters after 
they have been edited. 
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